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ΠΕΡΙΛΗΨΗ 

Η ισχαιμία αποτελεί την μεταβολική προσβολή κατά την οποία η ροή του αίματος σε κάποιον 

ιστό είναι περιορισμένη με αποτέλεσμα την μειωμένη πρόσβαση σε οξυγόνο και μεταβολικά 

υποστρώματα. Ανάλογα με τη χρονική διάρκεια της ισχαιμίας η μορφολογία του ιστού 

μπορεί να αλλοιωθεί ή ακόμα να οδηγηθεί σε νέκρωση. Σε προηγούμενες μελέτες του 

Εργαστηρίου Φαρμακολογίας διερευνήθηκε η επίδραση της ισχαιμίας στην απελευθέρωση 

των δύο κυριότερων νευροδιαβιβαστών: το γλουταμινικό οξύ (κύριος διεγερτικός) και το γ-

αμινοβουτυρικό οξύ (GABA - κύριος ανασταλτικός) σε ιστολογικά παρασκεύασματα 

αμφιβληστροειδή και ιππόκαμπου αρουραίου. Διαπιστώθηκε ότι η ισχαιμία έχει διφασική 

επίδραση (αρχικά μείωση και στη συνέχεια αύξηση)  στην απελευθέρωση ασπαρτικού οξέος 

(σταθερό ανάλογο του γλουταμινικού οξέος) από τον αμφιβληστροειδή, ενώ προκαλεί 

αύξηση της απελευθέρωσής του από τον ιππόκαμπο. Σε ότι αφορά το GABA, και στους δύο 

ιστούς παρατηρήθηκε αύξηση της απελευθέρωσής του υπό την επίδραση της ισχαιμίας. 

Περαιτέρω μελέτες στον αμφιβληστροειδή, έδειξαν ότι οι δύο συνιστώσες της ισχαιμίας 

(υποξία και υπογλυκαιμία) έχουν διαφορετική επίδραση στην απελευθέρωση αυτών των 

νευροδιαβιβαστών. Συγκεκριμένα, διαπιστώθηκε ότι η υποξία, προκαλεί μείωση ενώ η 

υπογλυκαιμία αύξηση της απελευθέρωσης και των δύο νευροδιαβιβαστών.  

Στην παρούσα πτυχιακή εργασία σκοπός ήταν η μελέτη της επίδρασης της ισχαιμίας, 

υπογλυκαιμίας και υποξίας σε αμφιβληστροειδή και ιππόκαμπο και συγκεκριμένα στις 

πιθανές αλλαγές που προκαλούν οι μεταβολικές αυτές προσβολές στη μορφολογία των 

ιστών, στην έκφραση γνωστών νευρωνικών [GABA και νευρωνική συνθάση του ΝΟ. (nNOS)] 

και βιοχημικών δεικτών ισχαιμίας [ενδοθηλιακή συνθάση του ΝΟ. (eNOS)]. Κατά την 

παρούσα πειραματική διαδικασία τηρήθηκε το ίδιο πρωτόκολλο με τα προηγούμενα 

πειράματα απελευθέρωσης νευροδιαβιβαστών του Εργαστηρίου Φαρμακολογίας και 

συλλέχθηκαν οι ιστοί προκειμένου να γίνουν οι απαραίτητες ιστολογικές μελέτες. 

Συγκεκριμένα, οι ιστοί τοποθετήθηκαν σε φιαλίδια υπερδιάχυσης (ένας αμφιβληστροειδής 

και μια ραχιαία και μια κοιλιακή τομή ιππόκαμπου/φιαλίδιο). Μετά από μια αρχική περίοδο 

εξισορρόπησης (υπερδιάχυση των ιστών με φυσιολογικό τεχνητό εγκεφαλονωτιαίο υγρό 

παρουσία γλυκόζης και 95%O2/5%CO2 με ροή 1,2ml/min για μια ώρα), οι ιστοί διαχύθηκαν 

για 92 λεπτά: τα πρώτα 26 λεπτά με φυσιολογικής σύστασης τεχνητό εγκεφαλονωτιαίο υγρό 

και τα υπόλοιπα 66 λεπτά με τεχνητό εγκεφαλονωτιαίο υγρό αντίστοιχο των επιθυμητών 

μεταβολικών προσβολών. Μετά το πέρας του πειράματος, έγινε μονιμοποίηση, 

κρυοπροστασία, και ταχεία ψύξη των ιστών οι οποίοι διατηρήθηκαν στους -80oC μέχρι τη 

συλλογή τομών με τη βοήθεια κρυοτόμου και την ιστολογική και ανοσολογική τους χρώση. 

Σύμφωνα, με τα αποτελέσματα, η ισχαιμία προκάλεσε στατιστικώς σημαντική αύξηση στο 

πάχος της εξωτερικής και εσωτερικής κοκκώδους στοιβάδας καθώς και της εσωτερικής 

δικτυωτής στοιβάδας του αμφιβληστροειδή. Επιπλέον, η ισχαιμία και σε μικρότερο βαθμό η 

υπογλυκαιμία και η υποξία μείωσαν την ανοσοδραστικότητα του GABA στον ίδιο ιστό, ενώ 

δεν είχαν κάποια επίδραση στην έκφραση της nNOS και eNOS. Σε ότι αφορά τον ιππόκαμπο, 

παρατηρήθηκαν μορφολογικές αλλαγές στα πυραμιδικά κύτταρα των CA1 και CA3 πεδίων 

του ιππόκαμπου κυρίως υπό την επίδραση της ισχαιμίας και σε μικρότερο βαθμό υπό την 

επίδραση της υπογλυκαιμίας και της υποξίας. Τα αποτελέσματα της συγκεκριμένης μελέτης 

σε συνδυασμό με προηγούμενες μελέτες του εργαστηρίου υποδηλώνουν ότι η ισχαιμία, η 

υποξία και η υπογλυκαιμία επηρεάζουν κατά διαφορετικό τρόπο τόσο τη νευροδιαβίβαση 

όσο και τη μορφολογία των κυττάρων του αμφιβληστροειδή και του ιππόκαμπου αρουραίοu.  
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ABSTACT  

Ischemia is a metabolic disorder in which blood flow to a tissue is restricted resulting in 

reduced access to oxygen and metabolic substrates. Depending on the duration of ischemia, 

the morphology of the tissue can be altered or even lead to necrosis. 

Previous experiments in the Laboratory of Pharmacology have shown that ischemia and its 

componets, hypoxia and hypoglycaemia have a differential effect on the release and uptake 

of the two major stimulatory and inhibitory neurotransmitters; glutamic acid and γ-

aminobutyric acid (GABA), respectively from the rat retina, while ischemia leads to a 

significant increase of both neurotransmitters from the rat hippocampus.  

The aim of this dissertation was to study the effect of ischemia, hypoglycemia and hypoxia on 

the retina and hippocampus and in particular the possible changes caused by these metabolic 

insults on tissue morphology and the expression of known ischemia markers [GABA, and 

neuronal (nNOS) and endothelial (eNOS) NO. synthases]. The experiment followed the same 

protocol as the release experiments mentioned above and tissues were collected in order to 

perform the necessary histological studies. That is to say, after an hour of pre-superfusion 

tissues were superfused for 92 minutes with artificial cerebrospinal fluid (arti-CSF) at a rate of 

1.2ml/min; the first 26 minutes in glucose and oxygen artificial cerebrospinal fluid (arti-CSF) 

and the remaining 66 minutes in the arti-CSF of the respective desired metabolic insult. At the 

end of the experiment, tissues were fixed in 4% paraformaldehyde solution (PFA), 

cryoprotected in sucrose, snap-frosted in isopentan, and stored at -80oC. Subsequently, 10μm 

sections of both tissues were taken using a cryotome and histochemical studies were 

performed using Cresyl Violet staining and direct nNOS, iNOS and GABA 

immunohistochemistry. 

According to our results, ischemia led to a statistically significant increase of the thickness of 

the outer and inner nuclear layers as well as the internal plexiform layer of the retina. In 

addition, ischemia and to a lesser extent hypoglycaemia and hypoxia reduced the 

immunoactivity of GABA in the retina, while had no effect on the expression of nNOS and 

eNOS. As far as hippocampus is concerned, morphological changes were observed in the 

pyramidal cells of the CA1 and CA3 fields under ischemic and to a lesser extent under 

hypoglycaemic and hypoxic conditions. 

The results of this study, in combination with the results of previous studies in our lab, 

suggest that ischemia, hypoxia and hypoglycaemia affect in a differential way both the 

neurotransmission and morphology of the rat retina and hippocampus. 
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ΕΙΣΑΓΩΓΗ 

ΙΣΧΑΙΜΙΑ 
Ο όρος “ισχαιμία” προέρχεται από τις αρχαίες ελληνικές λέξεις “ἴσχω” που σημαίνει 

εμποδίζω και “αἷμα”. Σήμερα ο όρος περιγράφει την παθολογική κατάσταση κατά την οποία 

η ροή του αίματος σε κάποιο μέρος του σώματος είναι ανεπαρκής. Αυτή η κατάσταση έχει 

ως αποτέλεσμα να υπάρχει έλλειψη οξυγόνου στον ιστό, των υποστρωμάτων του 

μεταβολισμού αλλά και της απομάκρυνσης των κυτταρικών αποβλήτων.  

Σε αρχικό στάδιο η ισχαιμία αλλοιώνει την ομοιόσταση ενός ιστού οδηγώντας στον 

τραυματισμό του. Όταν όμως αυτό συμβαίνει για μεγάλο χρονικό διάστημα ο ιστός 

οδηγείται σε θάνατο (Osborne και συν., 2004).  

 

ΕΛΛΕΙΨΗ ΟΞΥΓΟΝΟΥ 

Όταν γίνεται αναφορά στην έλλειψη του οξυγόνου στον οργανισμό, χρησιμοποιούνται οι 

όροι ανοξία (anoxia) και υποξία (hypoxia). Ο όρος ανοξία αναφέρεται στην πλήρη έλλειψη 

οξυγόνου ενώ ο όρος υποξία αναφέρεται στην μείωση του οξυγόνου στον οργανισμό ή στον 

αντίστοιχο ιστό. Η ισχαιμία διακρίνεται σε ένα συνδυασμό υποξίας και ανοξίας χωρίς να 

οδηγούν από μόνοι τους αυτοί οι παράγοντες στην παθολογική αυτή κατάσταση (Osborne 

και συν., 2004). 

 

ΥΠΟΓΛΥΚΑΙΜΙΑ 

Η υπογλυκαιμία συνήθως ορίζεται ως η μείωση της συγκέντρωσης της γλυκόζης στο αίμα 

κάτω από 2,8 mmol/L. Η γλυκόζη αποτελεί ένα απαραίτητο ενεργειακό υπόστρωμα για το 

νευρικό σύστημα και η μείωση των επιπέδων της έχει ως αποτέλεσμα τη δυσλειτουργία του 

νευρικού συστήματος και δημιουργία παθολογικών καταστάσεων στον οργανισμό (Marshall 

& Bangert, 2011).  

 

Μεταβολικά μονοπάτια απελευθέρωσης ενέργειας και νευροδιαβίβαση 

Ως γνωστόν, οι οργανισμοί χρειάζονται ενέργεια για να επιβιώσουν. Στο κύτταρο 

πραγματοποιούνται 2 διαδικασίες απελευθέρωσης ενέργειας η αερόβια και η αναερόβια 

αναπνοή. Και για τις δύο διαδικασίες πρώτη ύλη αποτελεί η γλυκόζη η οποία ορίζεται και ως 

βασικό αναπνευστικό υπόστρωμα. Η γλυκόζη αντιπροσωπεύει την κύρια πηγή ενέργειας για 

τους οργανισμούς αφού μέσω της οξείδωσης της απελευθερώνεται ενέργεια με τη μορφή  

τριφωσφορικής αδενοσίνης (ATP), το κύριο ενεργειακό νόμισμα των κυττάρων. Επιπρόσθετα, 

η γλυκόζη μεταφέρεται μέσω του αιματοεγκεφαλικού φραγμού στον εγκέφαλο και 

χαρακτηρίζεται ως η καύσιμη ύλη του εγκεφάλου για την παραγωγή ενέργειας. 

 Η αερόβια αναπνοή χωρίζεται σε αναερόβια (γλυκόλυση) και αερόβια φάση ενώ η 

αναερόβια αναπνοή σε αλκοολική και γαλακτική ζύμωση. Η γλυκόλυση είναι μία αρχαία 

μεταβολική πορεία που πραγματοποιείται εξελικτικά από πολλούς οργανισμούς απουσία 

οξυγόνου και λαμβάνει χώρα στο κυτταρόπλασμα. Ένα μόριο γλυκόζης διασπάται ενζυμικά 

σε 2 μόρια πυροσταφιλικού οξέος με ταυτόχρονη παραγωγή 2 μορίων ATP. Ακολούθως, η 

αερόβια φάση (κύκλος κιτρικού οξέος και οξειδωτική φωσφορυλίωση), όπου λαμβάνει χώρα 

στη μιτοχονδριακή μήτρα, πραγματοποιείται παρουσία οξυγόνου όπου το πυροσταφυλικό 
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οξύ οξειδώνεται πλήρως και παράγονται 34 μόρια ATP γεγονός που καθιστά αυτή τη φάση 

15 φορές πιο αποτελεσματική για την παραγωγή ενέργειας. 

Η αναερόβια αναπνοή, δηλαδή η αλκοολική και γαλακτική ζύμωση, είναι μία βιοχημική οδός 

απελευθέρωσης ενέργειας στο κύτταρο απουσία οξυγόνου και χρησιμοποιείται από 

ορισμένα βακτήρια και μύκητες. Γαλακτική ζύμωση μπορεί να γίνει και σε ζωικούς 

οργανισμούς. Οι ζυμώσεις παράγουν ένα μικρό ποσοστό ενέργειας από την πλήρη καύση της 

γλυκόζης (2 ATP ανά μόριο γλυκόζης) και λόγω της μη διαθέσιμης ποσότητας οξυγόνου 

δίνουν το πλεονέκτημα στον οργανισμό να συνεχίσει την γλυκολυτική πορεία. Το 

πυροσταφυλικό οξύ μπορεί να μετατραπεί σε γαλακτικό οξύ ή αιθανόλη τα οποία λόγω της 

τοξικότητας τους αποβάλλονται ή δέχονται περαιτέρω επεξεργασία.  

Στην περίπτωση που η γλυκόζη απουσιάζει ή δεν υπάρχουν αρκετές ποσότητες για την 

διεκπεραίωση των μεταβολικών μονοπατιών απελευθέρωσης ενέργειας στα κύτταρα 

χρησιμοποιούνται άλλες ουσίες  που είναι διαθέσιμες. Οι ουσίες αυτές είναι λίπη, αμινοξέα, 

το γαλακτικό οξύ ή άλλοι υδατάνθρακες και με την κατάλληλη επεξεργασία 

(γλυκονεογένεση) από τον οργανισμό διασπώνται και εισέρχονται σε διάφορα σημεία της 

κυτταρικής αναπνοής ως αναπνευστικά υποστρώματα. Με αυτόν τον τρόπο συνεχίζει η 

παραγωγή ενέργειας και η φυσιολογική λειτουργία του οργανισμού.  

Ο εγκέφαλος αποτελεί το μοναδικό όργανο που χρησιμοποιεί κετονοσώματα ως εφεδρική 

γλυκόζη γιατί ο χρόνος που χρειάζονται τα λιπαρά οξέα να περάσουν τον αιματοεγκεφαλικό 

φραγμό είναι πολύ μεγάλος. Ο εγκέφαλος περιέχει μια μικρή συγκέντρωση γλυκογόνου 

αποθηκευμένη στα αστροκύτταρα και την εκμεταλλεύεται βραχυπρόθεσμα ως ενεργειακό 

καύσιμο. Με τη χρήση των κετονοσωμάτων, ο εγκέφαλος επιτρέπει στα ερυθρά αιμοσφαίρια 

να χρησιμοποιήσουν όση ποσότητα γλυκόζης έχει απομείνει στον οργανισμό  εφόσον δεν 

έχουν κάποια εναλλακτική λύση. Τα κετονοσώματα παράγονται στο ήπαρ ως παραπροϊόντα 

του μεταβολισμού των λιπαρών οξέων και απελευθερώνονται σε μεγάλες ποσότητες στο 

αίμα (Cunnane και Crawford, 2014). 

Σύμφωνα με μελέτες του Henry McIlwain (McIlwain, 1953) και περαιτέρω πειράματα των 

τελευταίων χρόνων απέδειξαν ότι και το γαλακτικό οξύ μπορεί να αποτελέσει πηγή ενέργειας 

για τον εγκέφαλο και είναι αρκετά αποτελεσματικό όσον αφορά τη νευρική λειτουργία όταν 

υπάρχει έλλειψη γλυκόζης ή οξυγόνου. Όταν η συγκέντρωση του στο πλάσμα είναι περίπου 

1,0 mM, διαπερνά τον αιματοεγκεφαλικό φραγμό μέσω ειδικού μεταφορέα 

μονοκαρβοξυλικών οξέων και παρέχει το 10% της ενέργειας που χρειάζεται ο εγκέφαλος. 

Αυξημένη συγκέντρωση ATP που προκύπτει από την οξείδωση του γαλακτικού οξέος οδηγεί 

σε κλείσιμο διαύλων K+ που είναι ευαίσθητοι στο ATP (KATP), οι μεμβράνες εκπολώνονται και 

ο νευρώνας ενεργοποιείται (Magistretti και Allaman, 2015). 

Ο ανθρώπινος εγκέφαλος είναι ένα ενεργειακά δαπανηρό όργανο και παρόλο που 

αντιστοιχεί μόνο στο 2% του ολικού σωματικού βάρους καταναλώνει το 20% του οξυγόνου 

και το 25%  της γλυκόζης  που είναι διαθέσιμο συνολικά στο σώμα. Στον εγκέφαλο περίπου 

το 30% της ενέργειας χρησιμοποιείται για την συναπτική διαβίβαση. Για αυτό το λόγο η 

απώλεια της συναπτικής λειτουργίας άρα και η αδυναμία της συναπτικής μετάδοσης είναι το 

πρώτο αποτέλεσμα της εγκεφαλικής ισχαιμίας εξαιτίας της μείωσης της συγκέντρωσης της 

τριφωσφορικής αδενοσίνης (ATP) στις συνάψεις καθώς οι νευροδιαβιβαστές δεν μπορούν να 

απελευθερωθούν από το προσυναπτικό άκρο (Hofmeijer και van Putten, 2012). 
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Το δυναμικό ηρεμίας της μεμβράνης (-50 με -90 mV) προκύπτει από τη μη ισοδύναμη 

κατανομή ιόντων εκατέρωθεν των νευρικών μεμβρανών. Αυτή η βαθμίδωση ιόντων 

οφείλεται στη λειτουργία των αντλιών ιόντων που εξαρτώνται από την ενέργεια (Na+/K+-

ATPαση) και διατηρούν τη διαφορά δυναμικού μεταξύ κυτταροπλάσματος και εξωκυττάριου 

χώρου. Το δυναμικό δράσης δημιουργείται όταν ένα ερέθισμα αυξάνει το δυναμικό ηρεμίας  

του κυττάρου και ως αποτέλεσμα απελευθερώνεται ο νευροδιαβιβαστής από το συναπτικό 

άκρο του νευρώνα (Ζίφα, 2017). Στο συναπτικό άκρο των νευρώνων εντοπίζεται υψηλή 

συγκέντρωση μιτοχονδρίων και αυτό δικαιολογεί την υψηλή ενεργειακή κατανάλωση του 

νευρώνα. Επίσης στον κύκλο του κιτρικού οξέος , ο οποίος λαμβάνει χώρα στα μιτοχόνδρια 

κατά την αερόβια αναπνοή, πραγματοποιούνται τα βασικά σημεία  για το μεταβολισμό των 

νευροδιαβιβαστών γλουταμινικό οξύ και GABA (Hofmeijer και van Putten, 2012). 

Στον εγκέφαλο οι διεγερτικοί νευρώνες είναι περισσότεροι από τους ανασταλτικούς 

νευρώνες (αναλογία 9 προς 1) και για αυτό το λόγο η γλουταμινεργική νευροδιαβίβαση 

μελετήθηκε εκτενέστερα ως προς την απελευθέρωση, τη δράση και την ανακύκλωση του 

γλουταμινικού οξέος και ως προς την ενεργειακή κατανάλωση που αυτή απαιτεί.  Η 

νευροδιαβίβαση του γλουταμινικού χωρίζεται σε τρία βασικά ενεργειακά βήματα (Εικόνα 1): 

1. Το δυναμικό δράσης που φτάνει στο προσυναπτικό άκρο του νευρώνα διεγείρει το 

άνοιγμα τασεο-εξαρτόμενων διαύλων ασβεστίου και την είσοδο ιόντων ασβεστίου 

(Ca2+), με αποτέλεσμα τη μεγάλη αύξηση της συγκέντρωσης ιόντων Ca2+ στη σύναψη. 

Αυτή η διαδικασία εισροής ιόντων Ca2+ καταναλώνει  12 000 μόρια ATP ανά κυστίδιο  

(Attwell και Laughlin, 2001). Τα συναπτικά κυστίδια συντήκονται  με την μεμβράνη 

του προσυναπτικού νευρώνα με τη βοήθεια της μεμβρανικής πρωτεΐνης συνταξίνη 

και κατανάλωση 400 ATP ανά κυστίδιο και ακολούθως απελευθερώνεται ο 

νευροδιαβιβαστής στην συναπτική σχισμή με κατανάλωση 1000 μορίων ATP ανά 

κυστίδιο (Hofmeijer, 2012). 

2. Το γλουταμινικό οξύ δεσμεύεται σε  μη-NMDA (υποδοχείς καϊνικού και AMPA)  και 

NMDA υποδοχείς που βρίσκονται τοποθετημένοι στη μεμβράνη του μετασυναπτικού 

νευρώνα. Ιοντικοί δίαυλοι ενεργοποιούνται και εισέρχονται στο κύτταρο ιόντα Na+ 

και Ca2+. Τα ιόντα Na+ εξέρχονται από τον μετασυναπτικό νευρώνα  μέσω του 

ανταλλάκτη 3Na+/2Κ+ και  τα ιόντα Ca2+ εξέρχονται μέσω του ανταλλάκτη 3Na+/Ca2+ 

με κατανάλωση 67 000 και 70 000 μορίων ATP ανά κυστίδιο γλουταμινικού, 

αντίστοιχα.  

3. Το γλουταμινικό οξύ που απελευθερώθηκε εκτός συναπτικής σχισμής 

προσλαμβάνεται κυρίως από μεταβοτροπικούς υποδοχείς γλουταμινεργικού 

(mGluRs) των αστροκυττάρων και της μικρογλοίας. Το γλουταμινικό που παραμένει 

στη σύναψη πακετάρεται και πάλι σε κυστίδια που τροφοδοτούνται από την Η+ 

ATPαση.  
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Εικόνα 1. Χρήση τριφωσφορικής αδενοσίνης (ATP) στα στάδια της συναπτικής απελευθέρωσης και  

νευροδιαβίβασης του γλουταμινικού  (Hofmeijer και van Putten, 2012). 

 

Συνολικά, με βάση τα παραπάνω, για την απελευθέρωση και την ανακύκλωση ενός κυστιδίου 

γλουταμινικού χρειάζεται να καταναλωθούν 164 000 μόρια ATP. Τα μονοπάτια μεταγωγής 

σήματος που διαδραματίζονται μετασυναπτικά καταναλώνουν το μεγαλύτερο ποσοστό 

ενέργειας (85%) σε σύγκριση με την ροή των ιόντων προσυναπτικά, την απελευθέρωση του 

γλουταμινικού και την ανακύκλωσή του (15%), ( Hofmeijer και van Putten, 2012). 

Κατά την εγκεφαλική ισχαιμία η λειτουργία των μιτοχονδρίων επηρεάζεται λόγω της 

αδυναμίας να παρέχεται φυσιολογικά στον ιστό γλυκόζη και οξυγόνο. Στην αρχή της 

ισχαιμίας λόγω της μειωμένης παροχής ενέργειας στον ιστό, αυξάνονται τα επίπεδα της 

αδενοσίνης η οποία εμποδίζει την είσοδο των ιόντων Ca2+ προσυναπτικά και αυτό έχει ως 

αποτέλεσμα να αναστέλλεται η απελευθέρωση γλουταμικού οξέος και η συναπτική 

δραστηριότητα να εξασθενεί σταδιακά (Fowler, 1990). Εάν η ισχαιμία διαρκέσει για μεγάλο 

χρονικό διάστημα, η μείωση των ιόντων λόγω αναστολής της μιτοχονδριακής λειτουργίας 

οδηγεί σε αναστροφή των προσυναπτικών μεταφορέων επαναπρόσληψης γλουταμινικού και 

αύξηση της συγκέντρωσης του εξωκυτταρικά. Αυτό οδηγεί στην ενεργοποίηση των 

υποδοχέων NMDA και εισροή ιόντων Ca2+ μετασυναπτικά με επακόλουθη εκπόλωση των 

μιτοχονδρίων, απελευθέρωση του κυτοχρώματος C και απόπτωση των νευρικών κυττάρων 

(Harris και συν., 2012). 
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ΑΜΦΙΒΛΗΣΤΟΕΙΔΗΣ 
 

Ανατομία 
 Ο αμφιβληστροειδής χιτώνας, ο οποίος βρίσκεται τοποθετημένος στο πίσω μέρος του 

ματιού, παρομοιάζεται ως το παράθυρο του εγκεφάλου προς τον κόσμο και αποτελεί μέρος 

του κεντρικού νευρικού συστήματος. Είναι ένα λεπτό στρώμα νευρώνων αποτελούμενο από 

5 κυτταρικούς τύπους (νευρικά κύτταρα) και είναι διατεταγμένα σε 3 στοιβάδες (Kandel και 

συν., 2013), (Εικόνα 2) : 

 Η εξωτερική κοκκώδης στοιβάδα (Outer nuclear layer) περιλαμβάνει τα κυτταρικά 

σώματα των φωτοϋποδοχέων (κωνία και ραβδία),  

 Η εσωτερική κοκκώδης στοιβάδα (Inner nuclear layer) περιλαμβάνει τα οριζόντια, τα 

δίπολα και τα βραχύινα κύτταρα  

 Η στοιβάδα των γαγγλιακών κυττάρων (Ganglion cell layer) περιλαμβάνει τα 

γαγγλιακά κύτταρα και κάποια εκτοπισμένα βραχύινα κύτταρα.  

Ανάμεσά τους υπάρχουν 2 στοιβάδες οπτικών ινών και συνάψεων που τις διαχωρίζουν: 

 Έξω δικτυωτή (Outer plexiform layer) και 

 Έσω δικτυωτή (Inner plexiform layer) στοιβάδα 

 
 

Εικόνα 2. A) Οι 5 στοιβάδες νευρώνων και συνάψεων που αποτελούν τον αμφιβληστροειδή. B) 
Κατηγορίες κυττάρων του αμφιβληστροειδή (Kandel και συν, 2013). 
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Η φωτοδιαβίβαση, η κύρια διαδικασία που συμβαίνει στον αμφιβληστρειδή, 

πραγματοποιείται από τους φωτοϋποδοχείς (φωτοευαίσθητα κύτταρα) της εξωτερικής 

στοιβάδας του αμφιβληστροειδή όπου μετατρέπουν το οπτικό σήμα σε νευρικό σήμα 

(δυναμικά δράσης), ( Ζίφα 2017).  

 

Η μετατροπή αυτή εκτελείται σε τρία στάδια:  

1. Μεταγωγή του οπτικού ερεθίσματος από τους φωτοϋποδοχείς 

2. Μεταφορά των νευρικών σημάτων μέσω χημικών συνάψεων στα δίπολα κύτταρα 

3. Μεταφορά στα γαγγλιακά κύτταρα, οι άξονες των οποίων συγκροτούν το οπτικό 

νεύρο και προβάλουν στον εγκέφαλο μεταφέροντας νευρικές ώσεις (Stackman, 

2004) 

Αυτό αποτελεί το κάθετο μονοπάτι μετάδοσης της οπτικής πληροφορίας, ενώ υπάρχει και το 

οριζόντιο μονοπάτι μεταβίβασης σήματος στο οποίο συμμετέχουν τα οριζόντια και τα 

βραχύινα κύτταρα που τροποποιούν τη μετάδοση του σήματος στο επίπεδο της εξωτερικής 

και εσωτερικής κοκκώδους στοιβάδας, αντίστοιχα.  

Οι διαφορετικοί τύποι κυττάρων δίνουν το προνόμιο στον αμφιβληστροειδή να δημιουργεί 

διάφορα μονοπάτια ταυτόχρονης μεταφοράς νευρικών σημάτων στον εγκέφαλο. Όμως, 

ανάλογα με την ένταση του φωτός κατά τη διάρκεια της ημέρας δημιουργούνται 

εξειδικευμένα μονοπάτια μεταγωγής σήματος τα οποία όλα καταλήγουν στον εγκέφαλό με 

τον ίδιο τρόπο (Smith και συν., 1986). Το φως ταξιδεύει διαμέσου των κυτταρικών 

στοιβάδων μέχρι να φτάσει στους φωτοϋποδοχείς και έπειτα στο χρωμοφόρο μελάχρουν 

επιθήλιο αποτρέποντας τη διάχυση του φωτός προς τα πίσω (Ζίφα 2017). Το μελάχρουν 

επιθήλιο αποτελείται από μία στοιβάδα κυττάρων στα οποία τα άκρα των εξωτερικών 

τμημάτων των ραβδίων προεκβάλλουν μέσα σε αυτά. Βασικοί ρόλοι της στοιβάδας αυτής 

αποτελούν η ενζυμική μετατροπή της trans ρετινάλης ξανά σε 11-cis ρετινάλη, αλλά και η 

ανακύκλωση των μεμβρανών του εξωτερικού τμήματος των φωτοϋποδοχέων μέσω 

φαγοκυττάρωσης (Yingbin Fu & King-Wai Yau 2007, Kandel και συν., 2013).  

 

Φωτοϋποδοχείς 

 

Οι φωτοϋποδοχείς είναι επιμήκεις νευροευαίσθητα κύτταρα και μοιράζονται μία κοινή δομή 

που συμπεριλαμβάνει το εξωτερικό τμήμα (outer segment), το εσωτερικό τμήμα (inner 

segment), το κεντρικό σώμα (πυρήνας) και τη συναπτική απόληξη. Το εξωτερικό τμήμα 

αποτελεί την φωτοευαίσθητη περιοχή με ενδοκυτταρικούς δίσκους, όπου στη μεμβράνη 

τους βρίσκονται μόρια της χρωστικής ροδοψίνης. Το εσωτερικό τμήμα περιέχει τον πυρήνα, 

τα μιτοχόνδρια και άλλα οργανίδια που λαμβάνουν μέρος στην πρωτεϊνοσύνθεση και στην 

αναδίπλωση των πρωτεϊνών (Ζίφα 2017),  (Εικόνα 3). 
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Εικόνα 3. Δομή των ραβδίων και κωνίων (Ζίφα 2017). 

 

Οι φωτοϋποδοχείς των θηλαστικών διακρίνονται σε 2 τύπους λόγω των λειτουργικών και 

μορφολογικών τους διαφορών, τα ραβδία και τα κωνία. Μορφολογικά τα ραβδία έχουν ένα 

πιο μακρύ και κυλινδρικού σχήματος εξωτερικό τμήμα του οποίου οι δίσκοι διαχωρίζονται 

από την πλασματική μεμβράνη και είναι περισσότεροι σε αριθμό. Αντιθέτως, τα κωνία έχουν 

πιο κοντό και με κωνικό σχήμα εξωτερικό τμήμα και οι δίσκοι τους αποτελούν συνέχεια της 

πλασματικής μεμβράνης και είναι λιγότεροι αριθμητικά.  Λειτουργικά τα ραβδία είναι 

υπεύθυνα για την όραση σε αμυδρό φως, αν και είναι ευαίσθητα σε όλες τις διακυμάνσεις 

της έντασης του φωτός, ενώ τα κωνία είναι υπεύθυνα για την έγχρωμη και την υψηλής 

ευκρίνειας όραση κατά τη διάρκεια της ημέρας. Υπάρχουν 3 τύποι κωνίων με διαφορετικού 

τύπου οψίνες ανάλογα με την διακύμανση της έντασης του φωτός, ενώ ένας μόνο τύπος 

ραβδίων με ευαισθησία περίπου στα 500 nm (Kandel και συν., 2013).  

Οι τρεις τύποι κωνίων είναι οι: 

1. L (long wave) με ευαισθησία σε μεγάλα μήκη κύματος (564 nm – κόκκινο) 

2. M (medium wave) με ευαισθησία σε μεσαίου μήκους κύματος (533 nm – πράσινο) 

3. S (short wave) με ευαισθησία σε μικρού μήκους κύματος (437 nm – μπλε), (Gaouras, 

1984) 

Η κύρια φωτοευαίσθητη χρωστική, η ροδοψίνη, αποτελείται από ένα GPCR υποδοχέα, την 

οψίνη, μαζί με τον προσδέτη, την 11-cis ρετινάλη (παράγωγο της βιταμίνης Α), και 

εντοπίζονται στη μεμβράνη των δίσκων. Η 11-cis ρετινάλη προέρχεται από το μελάχρουν 

επιθήλιο και μεταφέρεται στους δίσκους μέσω ειδικών μορίων (πρωτεΐνες δέσμευσης, IRBP), 

(Kolb και συν., 1995).  

Παρουσία φωτός η cis ρετινάλη ισομεριώνεται σε trans μορφή και ενεργοποιείται στο άκρο 

του εσωτερικού τμήματος των φωτοϋποδοχέων. Η ενεργοποιημένη ροδοψίνη ενεργοποιεί 

με τη σειρά της μία G πρωτεΐνη, την τρανσδουσίνη, επάγοντας την ανταλλαγή του 

συνδεδεμένου με αυτήν GDP με GTP. Η ενεργή μορφή τρανσδουσίνης-GTP αλληλεπιδρά με 

μία φωσφοδιεστεράση στη μεμβράνη των δίσκων αυξάνοντας την συχνότητα υδρόλυσης του 

cGMP σε 5'-GMP (Kandel και συν., 2013).  
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Απουσία φωτός, το cGMP βρίσκεται σε υψηλή συγκέντρωση επηρεάζοντας την εισροή 

ιόντων Na+ μέσω του Na+/Ca2+ -K+ ανταλλάκτη της εξωτερικής στοιβάδας, εκπολώνοντας (-40 

mV) τον φωτοϋποδοχέα δημιουργώντας ένα “σκοτεινό ρεύμα”. Αυτή η εκπόλωση οδηγεί 

στην απελευθέρωση του γλουταμινικού από τη συναπτική απόληξη των φωτοϋποδοχέων 

στις συνάψεις με τους διάμεσους νευρώνες (Kolb και συν., 1995), (Εικόνα 4). 

Καθώς όμως το φως προσπίπτει στον αμφιβληστροειδή, προτού μπει μέσα στους 

φωτοϋποδοχείς διαπερνά τις στοιβάδες των νευρικών κυττάρων μέχρι να φτάσει στο 

μελάχρουν επιθήλιο. Στη στοιβάδα αυτή βρίσκονται τα μεταβολικά ένζυμα που 

επαναφέρουν την trans ρετινάλη στην αρχική της μορφή και περιέχουν τη χρωστική μελανίνη 

που είναι υπεύθυνη για την απορρόφηση του φωτός που έχει διαπεράσει τους δίσκους. Τα 

κανάλια κατιόντων που ήταν ενεργοποιημένα κατά τη διάρκεια του “σκοτεινού ρεύματος” 

κλείνουν λόγω της μείωσης του cGMP, με αποτέλεσμα την υπερπόλωση της μεμβράνης των 

φωτοϋποδοχέων και αναστολή της απελευθέρωσης γλουταμινικού. Μετά τη 

απενεργοποίηση της φωσφοδιεστεράσης, η συγκέντρωση cGMP επανέρχεται στα 

φυσιολογικά επίπεδα με τη δράση μίας γουανυλικής κυκλάσης (GC) που παράγει cGMP από 

GTP και έτσι τα κανάλια ιόντων της μεμβράνης ανοίγουν και ο φωτοϋποδοχέας εκπολώνεται 

και πάλι (Ζίφα 2017, Kolb και συν., 1995, Yau 1994).  

 

 
Εικόνα 4 . Φωτοδιαβίβαση (Kandel και συν., 2013). 

 

Αιμάτωση 

Το οπτικό νεύρο οριοθετείται στο κέντρο του αμφιβληστροειδή και από αυτό προέρχονται τα 

κύρια αγγεία αιμάτωσης του αμφιβληστροειδή. Στα θηλαστικά οι δύο κύριες πηγές 

αιμάτωσης στον αμφιβληστροειδή είναι η κεντρική αρτηρία του αμφιβληστροειδούς και τα 

χοριοειδή αιμοφόρα αγγεία. Το χόριο δέχεται τη μεγαλύτερη αιμάτωση και έχει καθοριστικό 

ρόλο στη διατήρηση και τροφοδότηση των εξωτερικών τμημάτων του αμφιβληστροειδούς 

και ιδιαίτερα των φωτοϋποδοχέων. Ενώ μέσω της κεντρικής αρτηρίας, η οποία προέρχεται 

από το οπτικό νεύρο, μία μικρότερη ποσότητα αίματος συντηρεί το εσωτερικό μέρος του 

αμφιβληστροειδούς (Henkind και συν., 1979).  
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Οι διακλαδώσεις της κεντρικής αρτηρίας στο εσωτερικό τροφοδοτούν τρεις στοιβάδες 

τριχοειδών: α) τα ακτινωτά περιφερικά τριχοειδή (RPCs), β) το εσωτερικό και γ) το εξωτερικό 

στρώμα τριχοειδών. Τα ακτινωτά περιφερικά τριχοειδή αγγεία αποτελούν την εξωτερική 

στοιβάδα των τριχοειδών αγγείων η οποία βρίσκεται στο εσωτερικό τμήμα των νευρικών 

ινών του οπτικού δίσκου. Τα εσωτερικά τριχοειδή αγγεία βρίσκονται στη στοιβάδα των 

γαγγλιακών κύτταρων ενώ η εξωτερική στοιβάδα τριχοειδών εκτείνεται από την εσωτερική 

δικτυωτή στοιβάδα μέχρι την εξωτερική δικτυωτή στοιβάδα διαμέσου της εσωτερικής 

κοκκώδους στοιβάδας (Zhang, 1994). Επίσης μεταξύ της εξωτερικής και εσωτερικής 

στοιβάδας υπάρχει αυξημένος αριθμός από φλεβίδια τα οποία μέσω του φλεβικού 

συστήματος καταλήγουν στην κεντρική αρτηρία του αμφιβληστροειδούς (Kolb και συν., 

1995), (Εικόνα 5). 

Οι χοριοειδικές αρτηρίες προέρχονται από τις οπίσθιες ακτινωτές αρτηρίες και κάποιες 

διακλαδώσεις της ζίννειας ζώνης (περιφερικά του οπτικού δίσκου). Κάθε οπίσθια ακτινωτή 

αρτηρία ξεχωριστά, διακλαδίζεται σε λοβούς τριχοειδών τροφοδοτώντας συγκεκριμένες 

περιοχές στο χόριο (Hayreh και συν., 1975). Οι αρτηρίες αυτές διαπερνούν τον σκληρό 

χιτώνα που υπάρχει περιφερικά του οπτικού νεύρου και δημιουργούν τρεις στοιβάδες 

αγγείων στο χόριο: εξωτερικό, μεσαίο και εσωτερικό. Στο εξωτερικό βρίσκονται οι αρτηρίες 

και οι φλέβες, στο μεσαίο τα αρτηρίδια και τα φλεβίδια, και στο εσωτερικό τα τριχοειδή 

αγγεία (Zhang, 1994). Οι φλεβικοί λοβοί στις στοιβάδες αυτές διακλαδίζονται σε φλεβίδια 

και φλέβες που κατευθύνονται προς το βολβό του ματιού (eyeball) για να εισέλθουν στο 

χόριο, διαπερνώντας τον σκληρό χιτώνα και ενώνονται στην οφθαλμική φλέβα (Kolb και συν., 

1995). 

 
Εικόνα 5. Οι τρεις στοιβάδες αγγείων στο χόριο. Διπλό βέλος = αρτηρίες και φλέβες της εξωτερικής 

στοιβάδας, λευκό βέλος = αρτηρίες και φλέβες της ενδιάμεσης στοιβάδας, αστέρι = τριχοειδή της 

εσωτερικής στοιβάδας (Zhang , 1994). 
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ΙΠΠΟΚΑΜΠΟΣ 
  

Ο όρος «ιππόκαμπος» προέρχεται από τις αρχαίες ελληνικές λέξεις «ίππος» που σημαίνει 

άλογο και «κάμπη» που σημαίνει θαλάσσιο τέρας και αναφέρεται στο σχήμα της δομής του 

που μοιάζει με θαλάσσιο ιππόκαμπο (Lewis, 1923). Αποτελεί μία από τις πιο καλά 

μελετημένες δομές του εγκεφάλου και έχει καθοριστικό ρόλο στις διαδικασίες μνήμης και 

μάθησης καθώς παρέχει στον εγκέφαλο ένα χωροχρονικό πλαίσιο (Knierim, 2015).  

Ως γενικός όρος χρησιμοποιείται ο ιπποκάμπειος σχηματισμός ο οποίος αποτελείται από τον 

υππόκαμπο, την παραϊπποκάμπεια έλικα (περιλαμβάνει τον ενδορρινικό φλοιό) και την 

οδοντωτή έλικα (Brown & Zador, 1990).  

Ο ιππόκαμπος αποτελεί βασικό στοιχείο του μεταιχμιακού συστήματος (limbic system), μαζί 

με την αμυγδαλή, τον υποθάλαμο, την παραϊπποκάμπεια έλικα, την ψαλίδα (fornix), την 

έλικα του προσαγωγίου (cingulate gyrus) και τον επικληνή πυρήνα του διαφράγματος (Kandel 

και συν., 2013), (Εικόνα 6). Λόγω αυτού του δικτύου αλληλεπιδράσεων, το μεταιχμιακό 

σύστημα εμπλέκεται κυρίως στη δημιουργία των συναισθημάτων, αλλά και στη δημιουργία 

μνήμης και μάθησης.   

 

 

Εικόνα 6. Μέρη του μεταιχμιακού συστήματος (μπλε χρώμα), (Kandel και συν., 2013) 

 

Ανατομία  
Ο ιππόκαμπος βρίσκεται τοποθετημένος στην έσω επιφάνεια του κροταφικού λοβού. Έχει 

επίμηκες σχήμα το οποίο παρομοιάζεται με το γράμμα C και διαχωρίζεται σε 2 βασικές 

περιοχές : το αμμώνιο κέρας ή κυρίως ιππόκαμπο και την οδοντωτή έλικα. Κάθε περιοχή 

περιέχει πυραμιδικά και κοκκώδη κύτταρα.  Ο ιππόκαμπος στους επίμυες, λόγω της 

ανατομικής του θέσης, διακρίνεται σε ραχιαίο και κοιλιακό και στα πρωτεύοντα πρόσθιο και 

οπίσθιο. Οι οριοθετήσεις αυτές φαίνεται πως δεν εμπλέκονται στις ίδιες λειτουργίες αφού ο 

ραχιαίος ιππόκαμπος  σχετίζεται με τη μνήμη, ενώ ο κοιλιακός σχετίζεται με τα 

συναισθήματα (Fanselow & Dong 2010), (Εικόνα 7). 
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Εικόνα 7. Μορφολογία ραχιαίου (DH = dorsal hippocampus) και κοιλιακού ιπποκάμπου (VH = ventral 

hippocampus), (Maggio & Segal 2009). 

Η ραχιαία επιφάνεια του ιππόκαμπου καλύπτεται από μία λεπτή στοιβάδα λευκής ουσίας 

που ονομάζεται σκάφη (alveus) και συνίσταται από νευράξονες των πυραμιδικών και 

πολύμορφων νευρώνων του υποθέματος (subiculum) και του κυρίως ιππόκαμπου (Tatu & 

Vuillier 2014).  

 

Η οδοντωτή έλικα απαρτίζεται από τρεις βασικές στοιβάδες:  

 Εξωτερικά η μοριακή στοιβάδα (molecular layer), αποτελείται από δενδρίτες των 

κοκκωδών κυττάρων  

 Ενδιάμεσα η κοκκώδης στοιβάδα, αποτελείται από τα σώματα των κοκκωδών 

κυττάρων  

 Εσωτερικά η στοιβάδα πολυμορφικών κυττάρων (polymorphic layer ή hilus) της 

οποίας τα κύτταρα καθορίζουν τα όρια μεταξύ οδοντωτής έλικας και CA3 περιοχής.  

Η οδοντωτή έλικα αποτελείται κυρίως από κοκκώδη κύτταρα, σε αντίθεση με τον κυρίως 

ιππόκαμπο που αποτελείται ως επί το πλείστον από πυραμιδικά κύτταρα (Hannula & Duff, 

2017). 

Τα κοκκώδη κύτταρα είναι σφαιρικά κυτταρικά σώματα που είναι τοποθετημένα ανά 4 με 6 

κύτταρα κατά πάχος στο στρώμα των κοκκίων. Είναι διεγερτικά κύτταρα και ως κύριο 

νευροδιαβιβαστή χρησιμοποιούν το γλουταμινικό οξύ. Λόγω της ιδιότητας των δενδρίτων να 

αναδύονται από το πάνω μέρος ενός κυτταρικού σώματος, τα κοκκώδη κύτταρα θεωρούνται 

μονοπολικοί νευρώνες και οι άξονες τους λόγω της ιδιαίτερης μορφολογίας τους 

ονομάζονται βρυώδεις ίνες (mossy fibers). Οι άξονες των κοκκωδών κυττάρων δημιουργούν 

συνάψεις με τα πυραμιδικά κύτταρα της περιοχής CA3 του ιππόκαμπου (https://www. kenhub. 

com/en/library/anatomy/hippocampus-structure-and-functions).  

 

https://www.kenhub.com/en/library/anatomy/hippocampus-structure-and-functions
https://www.kenhub.com/en/library/anatomy/hippocampus-structure-and-functions
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Εικόνα 8 . Βασική ανατομία ιπποκάμπου (Neves και συν., 2008) 

Το αμμώνιο κέρας διαχωρίζεται στις περιοχές CA1 με CA4 (CA= Cornu Ammonis). Στις 

περιοχές αυτές εντοπίζονται τα πυραμιδικά κύτταρα (Εικόνα 9). 

Οι περιοχές CA1 και CA3 αποτελούν το μεγαλύτερο μέρος του ιππόκαμπου. Οι νευρώνες 

στην περιοχή CA1 είναι συγκριτικά μικρότεροι σε μήκος από τις υπόλοιπες περιοχές αλλά ο 

υποπληθυσμός των πυραμιδικών κυττάρων είναι πιο ομογενής (Ishizuka και συν., 1995). Η 

περιοχή CA2, που βρίσκεται ανάμεσα στις CA1 και CA3, περιέχει ένα περιορισμένο και 

συμπαγές στρώμα πυραμιδικών κυττάρων του οποίου τα όρια δύσκολα καθορίζονται, ιδίως 

στον ανθρώπινο εγκέφαλο (Schultz & Engelhardt 2014). Στην CA3 το μήκος των νευρώνων 

εξαρτάται από την τοποθέτηση τους, δηλαδή εάν ο νευρώνας βρίσκεται πιο κοντά στην 

οδοντωτή έλικα τότε έχει μικρότερο μήκος, ενώ όταν βρίσκεται κοντά στην CA1 είναι 

μεγαλύτερο (Ishizuka και συν., 1995). Ένα ιδιαίτερο χαρακτηριστικό της CA3 περιοχής είναι 

ότι οι άξονες των πυραμιδικών κυττάρων προβάλλουν μέσω των ινών Schaffer στους 

δενδρίτες των πυραμιδικών κυττάρων της περιοχής CA1 (Neves και συν., 2008). Η CA4 

αναφέρεται στην πολυμορφική στοιβάδα της οδοντωτής έλικας και πλέον ο όρος δεν 

χρησιμοποιείται.  

Τα πυραμιδικά κύτταρα των περιοχών αυτών είναι διεγερτικοί νευρώνες οι οποίοι δέχονται 

ανασταλτικές (GABA) και διεγερτικές (γλουταμινικό οξύ) συνάψεις και αποτελούν τον κύριο 

κυτταρικό τύπο του ιππόκαμπου (Fröhlich, 2016).  
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Εικόνα 9 . Α) Περιοχές που απαρτίζουν το αμμώνιο κέρας Β) Κυτταρικοί τύποι των περιοχών του 

ιππόκαμπου (https://neupsykey.com/olfactory-and-limbic-systems) 

 

Ενδονευρώνες 

Στις στοιβάδες του ιππόκαμπου και της οδοντωτής έλικας εντοπίζονται οι ενδονευρώνες, 

ανασταλτικοί νευρώνες, που εκλύουν γ-αμινοβουτυρικό οξύ (GABA). Στην οδοντωτή έλικα, 

ως κύριο τύπο ενδονευρώνων ορίζονται: 

- τα πυραμιδικά καλαθοειδή κύτταρα των οποίων τα κυτταρικά σώματα εντοπίζονται 

στο όριο μεταξύ της κοκκώδους και της στοιβάδας των πολυμορφικών κυττάρων και 

- τα αξο-αξονικά κύτταρα της μοριακής στοιβάδας και καταλήγουν στην ζώνη έκφυσης 

των αξόνων των κοκκωδών κυττάρων (Freund & Buzsaki, 1996).  

 

 

Στον ιππόκαμπο οι ενδονευρώνες κατατάσσονται σε τρεις διακριτές ομάδες ανάλογα με το 

στόχο τους: 

- τα αξο-αξονικά κύτταρα, τα οποία συνάπτονται στο αρχικό τμήμα των πυραμιδικών 

νευρώνων 

- τα καλαθοειδή κύτταρα, τα οποία δημιουργούν συνάψεις με τα κυτταρικά σώματα 

των πυραμιδικών νευρώνων και μπορούν να δημιουργήσουν πολλαπλές συνάψεις 

με αυτούς  

- τα διστιβαδωτά κύτταρα σχηματίζουν συνάψεις με κορυφαίους και βασικούς 

δενδρίτες των πυραμιδικών νευρώνων (Shepherd, 2003) 

 

Διασυνδέσεις του ιπποκάμπου 
 
Ο ιππόκαμπος λαμβάνει πληθώρα αισθητικών και χωρικών πληροφοριών από τον 
ενδορρινικό φλοιό, για αυτό και ο ενδορρινικός φλοιός ορίζεται ως το σημείο έναρξης του 
μονοπατιού της εισόδου πληροφοριών. Οι πληροφορίες από τον ενδορρινικό φλοιό φθάνουν 
στους νευρώνες της CA1 μέσω δύο διεγερτικών οδών, την άμεση και την έμμεση οδό (Εικόνα 
10). 
Η άμεση οδός αρχίζει από τους νευρώνες της στοιβάδας III του ενδορρινικού φλοιού και οι 
άξονες των νευρώνων σχηματίζουν διεγερτικές συνάψεις με τους απομακρυσμένους 
δενδρίτες των CA1 πυραμιδικών νευρώνων και το υπόθεμα. Στην έμμεση οδό, η οποία 
χαρακτηρίζεται και ως πολυσυναπτικό μονοπάτι, οι πληροφορίες από τους νευρώνες της 
στοιβάδας II του ενδορρινικού φλοιού φθάνουν στους νευρώνες της περιοχής CA1 μέσω της 
τρισυναπτικής οδού (trisynaptic pathway). Στο πρώτο μέρος αυτού του μονοπατιού οι άξονες 
των νευρώνων της στοιβάδας II του ενδορρινικού φλοιού προβάλουν μέσω της 
διατιτραίνουσας οδού (perforant pathway) προς τα κοκκώδη κύτταρα της οδοντωτής έλικας 
δημιουργώντας διεγερτικές συνάψεις και απελευθερώνοντας γλουταμινικό οξύ. Ακολούθως 
οι άξονες των κοκκωδών κυττάρων προβάλλουν μέσω του μονοπατιού των βρυωδών ινών 
(mossy fiber) διεγείροντας έτσι τα πυραμιδικά κύτταρα της περιοχής CA3. Στο δεύτερο 
μέρος, οι άξονες της CA3 μέσω της οδού Schaffer δημιουργούν διεγερτικές συνάψεις στα 
πυραμιδικά κύτταρα της CA1. Το τρισυναπτικό κύκλωμα αντιπροσωπεύει την ανατομική 
συνδετικότητα των περιοχών του ιππόκαμπου και τη μονόδρομη πορεία των διεγερτικών 
οδών που συνδέουν την κάθε περιοχή.  Η άμεση και η έμμεση οδός πιθανόν να έχουν 
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καθοριστικό ρόλο για τη σωστή λειτουργία της μνήμης και της μάθησης (Kandel και συν., 
2013). 

 
 

 

Εικόνα 10. Οι πληροφορίες φτάνουν στον ιππόκαμπο από τον ενδορρινικό φλοιό μέσω του 

μονοπατιού των διατιτραίνουσων ινών (perforant pathway) και μπορούν να εισέλθουν άμεσα ή 

έμμεσα στους πυραμιδικούς νευρώνες της CA1 οι οποίοι αποτελούν τους κύριους νευρώνες εξόδου 

του ιππόκαμπου. Τα βέλη αντικατοπτρίζουν την ροή των πληροφοριών (μπλε χρώμα = άμεση οδός, 

κόκκινο χρώμα = έμμεση οδός), (Kandel και συν., 2013)  

 

Αιμάτωση 

Αρτηρίες στον ιππόκαμπο 

Οι διακλαδώσεις της οπίσθιας εγκεφαλικής αρτηρίας και της πρόσθιας χοριοειδούς αρτηρίας 

καθορίζουν την αρτηριακή αγγείωση του ιππόκαμπου καθώς σχηματίζουν το δίκτυο των 

επιφανειακών ιπποκάμπιων αρτηριών.  

Οι οπίσθιες αρτηρίες του ιππόκαμπου προεκτείνονται σε όλο το μήκος της κάτω πλευράς του 

ιπποκάμπειου σχηματισμού (subiculum) και φτάνουν μέχρι τον φλοιό στην αντίστοιχη 

περιοχή. Επίσης προεκτείνονται και στην επιφάνεια της οδοντωτής έλικας δημιουργώντας 

ένα ανατομικό δίκτυο που αιματώνει το σώμα και την ουρά του ιππόκαμπου. Οι 

επιφανειακές ιπποκάμπιες αρτηρίες επεκτείνονται ενδοπαρεγχυματικά σχηματίζοντας τις 

ενδοπαρεγχυματικές αρτηρίες οι οποίες μπορούν να κατηγοριοποιηθούν σε: 

 Μεγάλες κοιλιακές ενδοϊπποκάμπιες αρτηρίες που αιματώνουν τις CA1 και CA2.  
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 Μεγάλες ραχιαίες ενδοϊπποκάμπιες αρτηρίες που αιματώνουν τις CA4 και CA3 αλλά 

και την οδοντωτή έλικα περιφερικά.  

 Μικρές κοιλιακές ενδοϊπποκάμπιες αρτηρίες που αιματώνουν το κεντρικό τμήμα της 

οδοντωτής έλικας.  

 Και μικρές ραχιαίες ενδοϊπποκάμπιες αρτηρίες που αιματώνουν την CA3 και ένα 

μέρος της CA4 

 

Φλέβες στον ιππόκαμπο 

Οι ενδοϊπποκάμπιες φλέβες παρέχουν στον ιππόκαμπο φλεβική αγγείωση και απαρτίζονται 

από τις υποεπενδυματικές ενδοϊππόκαμπες φλέβες (subependymal intrahippocampal veins) 

και τις ενδοϊππόκαμπιες φλέβες των αυλάκων, οι οποίες κατευθύνονται προς τις 

επιφανειακές ιπποκάμπιες φλέβες.  

Οι επιφανειακές ιπποκάμπιες φλέβες σχηματίζουν δύο φλεβικά τόξα: το φλεβικό τόξο της 

ψαλιδο-οδοντωτής αύλακας και το φλεβικό τόξο της ιπποκάμπιας αύλακας. Το φλεβικό τόξο 

της ψαλιδο-οδοντωτής αύλακας δέχεται τις υποεπενδυματικές ενδοϊπποκάμπιες φλέβες και 

είναι ορατές στην ενδοκοιλιακή πλευρά του ιππόκαμπου. Το φλεβικό τόξο της ιπποκάμπιας 

αύλακας δέχεται τις φλέβες που προκύπτουν από τον ιππόκαμπο στο σημείο ένωσης της 

οδοντωτής έλικας και του κυρίως ιππόκαμπου (Tatu & Vuillier 2014).  

 
Εικόνα 11. Αγγεία στον ιππόκαμπο. S = υπόθεμα ιππόκαμπου (subiculum), GD = οδοντωτή έλικα, 1 = 
επιφανειακή αρτηρία ιππόκαμπου, 2 = μεγάλη κοιλιακή ιπποκάμπια αρτηρία, 3 = μεγάλη ραχιαία 
ιπποκάμπια αρτηρία, 4 = μικρή κοιλιακή ιπποκάμπια αρτηρία, 5=μικρή ραχιαία ιπποκάμπια αρτηρία, 7 
= φλεβικό τόξο της ψαλιδο-οδοντωτή αύλακας, 8 = φλεβικό τόξο της ιπποκάμπιας αύλακας, 9 = 
υποεπενδυματικές ενδοϊππόκαμπες φλέβες (subependymal intrahippocampal veins), 10 = τις 
ενδοϊππόκαμπιες φλέβες των αυλάκων, 11 = φλέβες υποθέματος ιπποκάμπου.  
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Ρόλος του ιππόκαμπου 
 
Ο ιππόκαμπος έχει καθοριστικό ρόλο στη διαδικασία της μνήμης και της μάθησης καθώς 
εμπλέκεται στην αποθήκευση της μνήμης και στην ανάκληση πληροφοριών (Makino και συν., 
2019). Ο ιππόκαμπος αποθηκεύει προσωρινά τη μακροπρόθεσμη μνήμη μέχρι να 
μεταφερθεί σε ειδικές περιοχές του φλοιού για τη μόνιμη αποθήκευση της (Kupfermann & 
Kandel 1999). Διάφορες παθολογικές καταστάσεις σχετίζονται με τον ιππόκαμπο καθώς 
αλλοίωση της δομής του μπορεί να οδηγήσει σε σοβαρές κλινικές διαταραχές. 
Χαρακτηριστικά παραδείγματα αποτελούν η νόσος Alzheimer και η επιληψία του κροταφικού 
λοβού (Brown & Zador 1990). 
 
Επιπρόσθετα, εξαιτίας των πολυάριθμων νευρικών συνάψεων μεταξύ του υποθάλαμου και 

του ιππόκαμπου, ο ιππόκαμπος συμβάλλει στην ορμονική ρύθμιση και σε διάφορες 

ενδοκρινικές διαδικασίες καθώς αυτή η μεταξύ τους σύνδεση αποτελεί μέρος του 

ανατροφοδοτικού μονοπατιού προς την υπόφυση. Η κοιλιακή πλευρά του ιππόκαμπου 

περιέχει πυκνές περιοχές νευρώνων που συγκεντρώνουν οιστραδιόλη, καθώς και υψηλές 

συγκεντρώσεις κορτικοστερόνης (γλυκοκορτικοειδές) που αναστέλλει τους νευρώνες που 

συγκεντρώνουν οιστραδιόλη (McEwen, 1982). 

 

  



25 
 

ΣΚΟΠΟΣ 

 

Με βάση τα συμπεράσματα προηγούμενων μελετών του Εργαστηρίου σύμφωνα με τα 

οποία: 

 Η ισχαιμία (έλλειψη Ο2 και γλυκόζης) προκαλεί αύξηση της απελευθέρωσης του 

ασπαρτικού οξέος (σταθερό ανάλογο του γλουταμινικού οξέος) και του GABA τόσο 

στον αμφιβληστροειδή όσο και στον ιππόκαμπο αρουραίου. 

 Η ισχαιμία έχει διφασική επίδραση (αρχικά μείωση και στη συνέχεια αύξηση)  στην 

απελευθέρωση ασπαρτικού οξέος από τον αμφιβληστροειδή. 

 Ενώ σε ό,τι αφορά τον αμφιβληστροειδή: 

o Δεν παρατηρείται διεγερτοτοξικότητα  υπό υποξικές συνθήκες.  

o Η υποξία μειώνει την αμφιβληστροειδική νευροδιαβίβαση τόσο με μείωση της 

απελευθέρωσης όσο και με αύξηση της επαναπρόσληψης γλουταμινικού οξέος 

και GABA.  

o Αν και η απελευθέρωση του GABA κατά την ισχαιμία είναι μεγαλύτερη από αυτή 

του γλουταμινικού οξέος, η υποξία και η υπογλυκαιμία έχουν ελάχιστη επίδραση 

στην απελευθέρωση του GABA σε σχέση με την απελευθέρωση του 

γλουταμινικού οξέος. 

Σκοπός της παρούσας πτυχιακής εργασίας ήταν η μελέτη της επίδρασης της ισχαιμίας, 

υπογλυκαιμίας και υποξίας στον αμφιβληστροειδή και ιππόκαμπο και συγκεκριμένα στις 

πιθανές αλλαγές που προκαλούν οι μεταβολικές αυτές προσβολές στη μορφολογία των 

ιστών, στην έκφραση γνωστών νευρωνικών δεικτών [GABA και νευρωνική συνθάση του ΝΟ 

(nNOS)] και βιοχημικών δεικτών της ισχαιμίας [ενδοθηλιακή συνθάση (eNOS)], συγκριτικά 

και στις 4 καταστάσεις (φυσιολογική κατάσταση, ισχαιμία, υπογλυκαιμία, υποξία). 

Με αφορμή προηγούμενα πειράματα απελευθέρωσης που πραγματοποιήθηκαν στο 

Εργαστήριο συλλέχθηκαν οι ιστοί προκειμένου να γίνουν οι απαραίτητες ιστολογικές μελέτες 

με χρώση Cresyl violet και ανοσοϊστοχημεία και να διευκρινιστούν τα βιοχημικά μονοπάτια 

που εμπλέκονται στη διαφορική επίδραση των μεταβολικών προσβολών. 
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ΜΕΘΟΔΟΛΟΓΙΑ 

ΠΕΙΡΑΜΑΤΟΖΩΑ 
Τα πειραματόζωα που χρησιμοποιήθηκαν στην παρούσα πτυχιακή εργασία ήταν αρσενικοί 

επίμυες Wistar ηλικίας ενός με ενάμιση μηνών, οι οποίοι μεγαλώνουν στο Εργαστήριο 

Φαρμακολογίας της Ιατρικής Σχολής του Πανεπιστημίου Θεσσαλίας. Οι επίμυες μεγάλωναν 

σε κλουβιά και είχαν ελεύθερη πρόσβαση σε νερό και τροφή. Η χρονική διάρκεια ημέρας και 

νύχτας ήταν 12 ώρες. Οι συνθήκες διαβίωσης και χειρισμού των πειραματόζωων ήταν οι 

αρμόζουσες βάσει της ελληνικής νομοθεσίας (Π. Δ 160/91).  

 

ΠΑΡΑΣΚΕΥΗ ΙΣΤΩΝ 

Αρχικά παρασκευάζονται τα πυκνά διαλύματα τα οποία αντιπροσωπεύουν το 

εγκεφαλονωτιαίο υγρό στο οποίο βρίσκονται φυσιολογικά οι ιστοί έτσι ώστε όταν οι ιστοί 

βρίσκονται εκτός του πειραματόζωου να είναι τοποθετημένοι σε ένα περιβάλλον που να 

μοιάζει με το φυσιολογικό και να αποτρέπεται η παραγωγή ανεπιθύμητων μεταβολιτών άρα 

και η αλλοίωση των αποτελεσμάτων.  

Τα πυκνά διαλύματα (Stock Solution) A (1.3 mM Ca2+) και Β είναι 20 φορές συμπυκνωμένα σε 

σχέση με τα τελικά διαλύματα. Τα Α, Β και C παρασκευάζονται μερικές μέρες πριν από τη 

μέρα διεξαγωγής του πειράματος και μπορούν να διατηρηθούν έως και ένα μήνα σε 

θερμοκρασία 4οC. Την ημέρα του πειράματος παρασκευάζονται τα D, E και F και τα τελικά 

Arti-CSF γλυκόζης και σουκρόζης για αποφυγή ανάπτυξης μικροοργανισμών. Το τελικό 

διάλυμα (Superfusion Buffer) γλυκόζης χρησιμοποιείται για το control και την υποξία ενώ της 

σουκρόζης στην υπογλυκαιμία και ισχαιμία. Στα διαλύματα αντικαθίσταται η γλυκόζη από 

σουκρόζη γιατί παρόλο που ο νευρικός ιστός δεν μπορεί να μεταβολίσει την σουκρόζη, η 

ωσμομοριακότητα μεταξύ των διαλυμάτων διατηρείται σταθερή. Η σύσταση των 

διαλυμάτων έχει ως εξής: 

 

Φυσιολογικό Ισχαιμία Υποξία Υπογλυκαιμία 

118mM NaCl 118mM NaCl 118mM NaCl 118mM NaCl 

4.8mM KCl 4.8mM KCl 4.8mM KCl 4.8mM KCl 

1.2mM MgSO4 1.2mM MgSO4 1.2mM MgSO4 1.2mM MgSO4 

25mM NaHCO3 25mM NaHCO3 25mM NaHCO3 25mM NaHCO3 

1.2mM KH2PO4 1.2mM KH2PO4 1.2mM KH2PO4 1.2mM KH2PO4 

0.57mM ascorbic 

acid 

0.57mM ascorbic 

acid 

0.57mM ascorbic 

acid 

0.57mM ascorbic 

acid 

0.03mM Na2EDTA 0.03mM Na2EDTA 0.03mM Na2EDTA 0.03mM Na2EDTA 

1.3mM CaCl2 1.3mM CaCl2 1.3mM CaCl2 1.3mM CaCl2 

11mM glucose 11mM sucrose 11mM glucose 11mM sucrose 

95%Ο2/5%CO2 95%N2/5%CO2 95%N2/5%CO2 95%Ο2/5%CO2 

 

Ακολούθως τα διαλύματα τοποθετούνται σε υδατόλουτρο θερμοκρασίας 36,5oC και μια 

μικρή ποσότητα στον πάγο και γίνεται κορεσμός τους για περίπου 1 ώρα με αέρια O2/CO2 

(95% και 5% αντίστοιχα) και N2 /CO2 (95% και 5% αντίστοιχα). Με αυτό τον τρόπο πέρα του 



27 
 

ότι επιτυγχάνεται κορεσμός των διαλυμάτων σε O2 και N2 ρυθμίζεται και το pH των 

διαλυμάτων με τη βοήθεια του CO2 στο 7,3-7,4.  

Μετά το κορεσμό των διαλυμάτων ακολουθεί η παρασκευή των ιστών. Για τη συλλογή του 

ιππόκαμπου και του αμφιβληστροειδoύς των πειραματόζωων, τα ζώα τοποθετούνται σε 

ειδικό γυάλινο σκεύος στο οποίο υπάρχει χαρτί εμποτισμένο με διαιθυλαιθέρα και 

αναισθητοποιούνται. Στη συνέχεια με τη χρήση της λαιμητόμου διαχωρίζεται το κεφάλι από 

το υπόλοιπο σώμα με σκοπό τον πιο εύκολο χειρισμό και απομόνωση των επιμέρους ιστών.  

Για την διεξαγωγή των επωάσεων της πειραματικής διαδικασίας ο ιππόκαμπος κόβεται σε 

εγκάρσιες τομές πάχους 250 μm με ειδικό μηχάνημα κοπής ιστών (McIlwain Tissue Chopper) 

ενώ ο αμφιβληστροειδής παραμένει ως έχει.  

Στο σύστημα υπάρχουν συνολικά 8 φιαλίδια υπερδιάχυσης, 2 για κάθε συνθήκη όπου στο 

ένα τοποθετείται ο αμφιβληστροειδής και στο άλλο 1 ραχιαία και 1 κοιλιακή τομή 

ιππόκαμπου. Σε κάθε φιαλίδιο υπάρχουν 2 σωληνάκια, ένα εισροής και ένα εκροής υγρού με 

ρυθμό 1,2 ml/min (2.05 rpm), με σκοπό τη συνεχή απορροή του υγρού διατηρώντας τη 

στάθμη σταθερή στα 500 μl και για να μην συσσωρεύονται μεταβολικοί παράγοντες στο 

φιαλίδιο υπερδιάχυσης.  

Για την εξισορρόπηση του συστήματος οι ιστοί προεπωάζονται για μια ώρα σε φυσιολογικό 

arti-CSF (buffer γλυκόζης μαζί με το οξυγόνο). Ακολούθως ξεκινούν οι χρόνοι υλοποίησης του 

πειράματος όπου οι ιστοί επωάζονται συνολικά για ακόμη 92 λεπτά, τα πρώτα 26 λεπτά σε 

buffer γλυκόζης και οξυγόνο και στα υπόλοιπα 66 τα σωληνάκια τοποθετούνται στα buffer 

που αντιστοιχούν στις επιθυμητές μεταβολικές προσβολές. Δηλαδή τα σωληνάκια στα 

δείγματα control παραμένουν όπως έχουν, στην υπογλυκαιμία στο buffer σουκρόζης μαζί με 

οξυγόνο, στην υποξία στο buffer γλυκόζης μαζί με N2 και στην ισχαιμία στο buffer σουκρόζης 

μαζί με N2.  

Μετά το πέρας των 92 λεπτών οι ιστοί αφαιρούνται από τα φιαλίδια υπερδιάχυσης και με 

λεπτούς χειρισμούς τοποθετούνται σε eppendorf και προστίθεται διάλυμα 4% 

παραφορμαλδεΰδης (PFA, σε 0,1Μ ΡΒ) για μία ώρα στους 4 oC, το οποίο δρα ως 

μονιμοποιητικό των ιστών. Μετά το πέρας της μίας ώρας η PFA αντικαθίσταται από διάλυμα 

30% σουκρόζης (σε 0,1Μ ΡΒ) το οποίο δρα ως κρυοπροστατευτικό για τους ιστούς και 

αφήνονται overnight, δηλαδή για 16-18 ώρες, στους 4 oC. Τα eppendorf όταν βρίσκονται 

στους 4 oC είναι τοποθετημένα οριζόντια και όχι κάθετα έτσι ώστε όλος ο ιστός να είναι 

εκτεθειμένος ομοιόμορφα στο διάλυμα της σουκρόζης. Η σουκρόζη δρα ως 

κρυοπροστατευτικό αφού λόγω ώσμωσης το νερό που υπάρχει στους ιστούς βγαίνει έξω και 

αντικαθίσταται από διάλυμα σουκρόζης. Αυτό το βήμα είναι σημαντικό γιατί το νερό λόγω 

της ψύξης που θα ακολουθήσει, αλλοιώνει την μορφολογία του ιστού. Το buffer 

φωσφορικών χρησιμοποιείται για την ρύθμιση του pH στο 7,3-7,4.  

Την επόμενη μέρα ακολουθεί το πάγωμα των ιστών. Αφαιρείται το διάλυμα σουκρόζης από 

τους ιστούς και οι ιστοί προσανατολίζονται σε στερεοποιητικό κρυοστάτη [cryostat 

embedding medium (Killik)] δημιουργώντας στην περίπτωση του αμφιβληστροειδή κύβους 

που υπάρχει μέσα στερεοποιημένος ο ιστός, ενώ στην περίπτωση του ιππόκαμπου ο ιστός 

στερεοποιείται ανάμεσα σε δύο αντικειμενοφόρους πλάκες και μια τρίτη ενδιάμεσα για να 

μείνει όσο το δυνατόν πιο επίπεδος ο ιστός και να μην διαλυθεί λόγω της πίεσης από τις 

πλάκες. Στη συνέχεια οι ιστοί βυθίζονται σε ισοπεντάνιο θερμοκρασίας -45 oC για ένα λεπτό 

και αποθηκεύονται στους -80 oC μέχρι να κοπούν.  
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Οι ιστοί κόβονται στον κρυοτόμο σε τομές πάχους 10 μm και στους -20 oC. Οι τομές 

προσκολλώνται διαδοχικά σε ζελατινοποιημένες αντικειμενοφόρους πλάκες οι οποίες 

βρίσκονται εκτός του κρυοτόμου και αποθηκεύονται στους -20 oC μέχρι τη διεξαγωγή της 

ιστολογίας και της ανοσοϊστοχημείας.  

 

ΖΕΛΑΤΙΝΟΠΟΙΗΣΗ ΑΝΤΙΚΕΙΜΕΝΟΦΟΡΩΝ ΠΛΑΚΩΝ 
Η ζελατινοποίηση των αντικειμενοφόρων πλακών πραγματοποιείται με την εμβύθιση τους σε 

μείγμα 0,5 w/v ζελατίνης (300 bloom) και 0,5 g δωδεκαϋδρικό θειικό χρωμιούχο κάλιο 

[CrK(SO4)2 · 12H2O] σε θερμοκρασία 45 oC και στέγνωμα σε θερμοκρασία δωματίου για 48 

ώρες.  

 

ΧΡΩΣΗ CRESYL VIOLET 

H Cresyl Violet αποτελεί μια χρώση (nucleic acid dye) η οποία σημαίνει τα σωμάτια Nissl που 

υπάρχουν στα σώματα και τους δενδρίτες των νευρικών κυττάρων. Η χρώση αυτή 

χρησιμοποιείται με σκοπό την εκτίμηση του αριθμού και της μορφολογίας των νευρώνων  

(Snyder και συν., 2018, Wilkinson 1992).  

Tα σωμάτια Nissl αποτελούνται από αδρό ενδοπλασματικό δίκτυο και ελεύθερα ριβοσώματα 

και αντιπροσωπεύουν τη μηχανή παραγωγής πρωτεϊνών του κυττάρου (Εικόνα 12). 

Δεδομένου ότι οι νευρώνες είναι κύτταρα με έντονη πρωτεϊνοσυνθετική ικανότητα, το 

κυτταρόπλασμα τους περιέχει μεγαλύτερο αριθμό σωματιδίων Nissl σε σχέση με άλλα 

κύτταρα. Εξαιτίας αυτής της έντονης πρωτεϊνοσυνθετικής δραστηριότητας των νευρώνων, η 

Cresyl Violet χρωματίζει στον εγκέφαλο εκλεκτικά το κυτταρόπλασμα των νευρώνων και όχι 

άλλων κυτταρικών τύπων. Το γεγονός αυτό καθιστά τη συγκεκριμένη χρώση σημαντική στην 

μελέτη της παθολογίας των νευρώνων και την κατανόηση της αρχιτεκτονικής των κυττάρων 

στις διάφορες περιοχές του εγκεφάλου. Η ορατότητα, η μορφολογία και το μέγεθος των 

σωμάτιων Nissl ποικίλει σημαντικά μεταξύ των νευρώνων ανάλογα με την παθολογική 

κατάσταση που βρίσκεται ο νευρώνας (Angevine 2002, Brady και συν., 2004) 

Οι αντικειμενοφόρες πλάκες, αφού αφέθηκαν λίγα λεπτά σε θερμοκρασία δωματίου για να 

ξεπαγώσουν, βυθίστηκαν διαδοχικά για 3 λεπτά σε διάλυμα αιθανόλης αυξανόμενης 

συγκέντρωσης (50%, 70%, 80%, 95% και 100%) για αφυδάτωση και μονιμοποίηση των ιστών. 

Ακολούθως οι πλάκες βυθίστηκαν διαδοχικά για 3 λεπτά σε διάλυμα αιθανόλης μειούμενης 

συγκέντρωσης (100%, 95%, 80%, 75% και 50%) για ενυδάτωση των ιστών και έπειτα 

επωάσθηακαν για 15 λεπτά σε διάλυμα cresyl violet (pH=4,5) το οποίο περιείχε 0,2 Μ οξικό 

Na+, 0,5% Cresyl Violet και dH2O. Οι ιστοί και πάλι αφυδατώνονται σε διαδοχικά διαλύματα 

αιθανόλης για 3 λεπτά, βυθίζονται μερικά λεπτά σε ξυλόλη και τέλος καλύπτονται με 

ιστολογικό υλικό κάλυψης DPX και αποθηκεύονται σε θερμοκρασία δωματίου.  

Η οπτική απεικόνιση υπό μεγέθυνση των αποτελεσμάτων της χρώσης έγινε με τη χρήση 

οπτικού μικροσκοπίου με αντικειμενικό φακό μεγέθυνσης x10. Το μικροσκόπιο στην 

προκειμένη περίπτωση ήταν συνδεδεμένο με κάμερα και μέσω του προγράμματος Leica 

έγινε η φωτογράφηση των αποτελεσμάτων.  
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Εικόνα 12. Σχηματική απεικόνιση νευρώνα σε ηλεκτρονικό μικροσκόπιο. Nis = Σωμάτιο Nissl         

(Angevine, 2002)  

 

 

Εικόνα 13. Εγκάρσια τομή εγκεφάλου ποντικού με χρώση Cresyl Violet (Snyder και συν., 2018) 
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ΑΝΟΣΟΪΣΤΟΧΗΜΕΙΑ (IHC) 

Η ανοσοϊστοχημεία αποτελεί μία τεχνική η οποία χρησιμοποιείται για τον εντοπισμό 

συστατικών των κυττάρων και των ιστών σε φυσιολογικές και παθολογικές καταστάσεις με τη 

χρήση ειδικών αντισωμάτων τα οποία έχουν την ικανότητα να αναγνωρίζουν αντιγόνα-

στόχους. Το αντίσωμα προσδένεται με εξειδίκευση σε μία περιοχή του αντιγόνου, τον 

επίτοπο.  

 Στην ανοσοϊστοχημεία μπορούν να χρησιμοποιηθούν μονοκλωνικά και πολυκλωνικά 

αντισώματα ανάλογα με την εφαρμογή αφού τα μονοκλωνικά αντισώματα στοχεύουν έναν 

επίτοπο, άρα είναι πιο ειδικά ,ενώ τα πολυκλωνικά δεσμεύονται σε διαφορετικούς 

επιτόπους άρα έχουν μεγαλύτερη ευαισθησία (Oliver & Jamur, 2009). 

 Τα αντισώματα που θα επιλεγούν πρέπει να έχουν υψηλό τίτλο αντισωμάτων και να 

βρίσκονται σε επαρκείς ποσότητες, και ως προς το αντιγόνο να είναι ειδικά και να έχουν 

υψηλή συγγένεια. Το πιο συνηθισμένο αντίσωμα που χρησιμοποιείται στην 

ανοσοϊστοχημεία είναι το IgG λόγω της ύπαρξης του σε υψηλά ποσοστά στο φυσιολογικό 

ορό.  

Ως βασικά βήματα στην ανοσοϊστοχημεία ορίζονται: η εύρεση του κατάλληλου αντιγόνου, 

προσθήκη του πρώτου αντισώματος, χρήση δεύτερου αντισώματος το οποίο προσδένεται 

στο πρώτο αντίσωμα και η προσθήκη κατάλληλου αντιδραστηρίου το οποίο βοηθά στον 

εντοπισμό του πρώτου αντισώματος.  

Υπάρχουν δύο μεθόδοι ανοσοϊστοχημείας, η άμεση και η έμμεση. Η χρήση του σημασμένου 

με ετικέτα πρώτου αντισώματος αποτελεί την άμεση μέθοδο που μπορεί να εφαρμοστεί 

στον ιστό, αλλά δεν χρησιμοποιείται αρκετά συχνά λόγω του ότι χρειάζονται μεγάλες 

συγκεντρώσεις πρώτων αντισωμάτων και σήμανση καθενός ξεχωριστά. Αντιθέτως, όταν είναι 

σημασμένο με κάποια ετικέτα το δεύτερο αντίσωμα, παρατηρείται ενίσχυση του σήματος 

και μπορεί να προσδεθεί με μία γκάμα πρώτων αντισωμάτων. Οι πιο ευρέως 

χρησιμοποιούμενες ετικέτες σε αυτήν την περίπτωση είναι οι φθορίζουσες ουσίες ή κάποιο 

ένζυμο (Magaki και συν., 2018). 

 

Ανοσοφθορισμός 

Ο ανοσοφθορισμός (IF) αποτελεί μία τεχνική ανοσοχημείας που δίνει τη δυνατότητα 

ανίχνευσης αντιγόνων σε διαφορετικούς ιστούς και κύτταρα με υψηλή ευαισθησία σήματος 

συγκριτικά με την ανοσοϊστοχημεία. Και σε αυτήν την τεχνική, όπως και στην 

ανοσοϊστοχημεία, υπάρχουν 2 μέθοδοι εντοπισμού των αντιγόνων : η άμεση με τη χρήση 

μόνο του πρώτου αντισώματος και η έμμεση με τη χρήση δεύτερου αντισώματος. Και στις 2 

μεθόδους το αντίσωμα είναι σημασμένο με χρωμοφόρο (φθορίζουσα ουσία). Κατά την 

άμεση μέθοδο το χρωμοφόρο είναι συνδεδεμένο με το πρώτο αντίσωμα το οποίο 

αλληλεπιδρά άμεσα με το αντιγόνο στόχο ενώ στην έμμεση μέθοδο το χρωμοφόρο είναι 

συνδεδεμένο με το δεύτερο αντίσωμα το οποίο αναγνωρίζει και συνδέεται με το σύμπλοκο 

πρώτου αντισώματος και αντιγόνου-στόχου (Εικόνα 14). Το πρώτο αντίσωμα ορίζεται ως το 

κατάλληλο όταν προέρχεται από διαφορετικό ζώο-ξενιστή από αυτό του δείγματος έτσι ώστε 

το δεύτερο αντίσωμα να μην αλληλεπιδρά με ενδογενείς ανοσοσφαιρίνες του δείγματος (Im 

και συν., 2018). 
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Εικόνα 14. Σχηματική αναπαράσταση του έμμεσου ανοσοφθορισμού (Im και συν., 2018).  

 

 

Επίσης, ο ανοσοφθορισμός παρέχει τη δυνατότητα εντοπισμού περισσότερων του ενός 

αντιγόνου ταυτόχρονα χρησιμοποιώντας διαφορετικά αντισώματα με φθορίζουσες ουσίες οι 

οποίες δεν αλληλεπιδρούν μεταξύ τους. Για μείωση της πιθανότητας της μη ειδικής 

δέσμευσης του δεύτερου αντισώματος, ο φυσιολογικός ορός προέρχεται από το ζώο-ξενιστή 

του δεύτερου αντισώματος. Όταν σε ένα δείγμα γίνεται ταυτόχρονη ανίχνευση δύο ή τριών 

πρωτεϊνών, τα πρώτα αντισώματα προέρχονται από διαφορετικούς ξενιστές και τα δεύτερα 

αντισώματα είναι σημασμένα με διαφορετικές φθορίζουσες ουσίες για επιτυχή 

αποτελέσματα.  

 

Πρωτόκολλο  

Στο παρόν πείραμα εφαρμόστηκε η τεχνική του έμμεσου ανοσοφθορισμού σε τομές 

αμφιβληστροειδή 10μm. Την πρώτη μέρα διεξαγωγής του πειράματος παρασκευάζεται το 

ρυθμιστικό διάλυμα TBS 0. 1 M (pH=7. 4), όπου περιέχει Trizma Base και NaCl, με σκοπό τη 

διατήρηση του pH σε σταθερά επίπεδα και διατηρείται στους 4οC. Ακολουθεί η απόψυξη των 

αντικειμενοφόρων πλακών για περίπου μισή ώρα και ξεπλύθηκαν δύο φορές με TBS και 

επωάστηκαν για 30 λεπτά σε διάλυμα 0,1Μ TBS που περιείχε 3,3% φυσιολογικό ορό 

γαϊδουριού (NDS, normal donkey serum). Ο φυσιολογικός ορός είναι από το ζώο από το 

οποίο προέρχεται το δεύτερο αντίσωμα με σκοπό τη μείωση της πιθανότητας της μη ειδικής 

δέσμευσης του δεύτερου αντισώματος με άλλα αντισώματα εκτός του πρώτου, όπου είναι 

και ο στόχος, δίνοντας ψευδώς θετικά αποτελέσματα. Στη συνέχεια, οι ιστοί ξεπλύθηκαν 

τρείς φορές με TBS και επωάστηκαν με το πρώτο αντίσωμα για 16-18 ώρες (overnight) σε 

θερμοκρασία δωματίου. Το πρώτο αντίσωμα διαλύθηκε σε διάλυμα 0,1M TBS το οποίο 

περιείχε 0,5% NDS και 0,3%Triton X-100. Το Triton X-100 είναι ένα απορρυπαντικό το οποίο 

καθιστά τις μεμβράνες των κυττάρων διαπερατές και εύκολα προσβάσιμο το εσωτερικό του 
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κυττάρου σε μικρά μόρια αλλά όταν χρησιμοποιείται σε υψηλές συγκεντρώσεις αλλοιώνει 

την μορφολογία του ιστού.  

Την επόμενη μέρα, οι ιστοί ξεπλύθηκαν τρείς φορές με 0,1M TBS και επωάστηκαν για 1,5 

ώρα σε θερμοκρασία δωματίου με φθορίζον δεύτερο αντίσωμα συνδεδεμένο με χρωστική 

CF. Οι τομές ξεπλύθηκα και πάλι τρείς φορές με TBS και καλύφθηκαν με υλικό κάλυψης 

φθορισμού με DAPI (συγκέντρωση 1:500 σε 0,1Μ TBS). Μετά την κάλυψη τους, οι 

αντικειμενοφόρες πλάκες αποθηκεύτηκαν στους 4οC μέχρι την παρατήρηση τους στο 

μικροσκόπιο φθορισμού. Λόγω της ευαισθησίας των χρωμογόνων στο φως οι χειρισμοί 

γίνονται υπό χαμηλό φωτισμό και η φωτογράφιση στο μικροσκόπιο φθορισμού γίνεται στο 

σκοτάδι.  

Ως πρώτο αντίσωμα χρησιμοποιήθηκαν:  

- Μονοκλωνικό αντίσωμα ανεπτυγμένο σε ποντίκι ενάντια στη νευρωνική 

συνθάση του ΝΟ (nNOS, συγκέντρωση 1:200) 

- Μονοκλωνικό αντίσωμα ανεπτυγμένο σε ποντίκι ενάντια στην ενδοθηλιακή 

συνθάση του ΝΟ (eNOS, συγκέντρωση 1:200) 

- Πολυκλωνικό αντίσωμα ανεπτυγμένο σε κουνέλι ενάντια στο GABA 

(συγκέντρωση 1:500) 

 

Ως δεύτερο αντίσωμα χρησιμοποιήθηκε πολυκλωνικό αντίσωμα γαϊδουριού έναντι των IgG 

(H+L) ανοσοσφαιρινών ποντικού (σε συγκέντρωση 1:200): 

- Πράσινη φθορίζουσα χρωστική CF488A 

- Κόκκινη φθορίζουσα χρωστική CF594 

Τα πολυκλωνικά δεύτερα αντισώματα είναι ικανά να αναγνωρίζουν πολλαπλούς επιτόπους 

πάνω στα πρώτα αντισώματα αυξάνοντας τα επίπεδα δέσμευσης και σήματος. 

 

ΑΝΑΛΥΣΗ ΕΙΚΟΝΩΝ 

Οι εικόνες που λήφθηκαν, για την χρώση Cresyl και τον ανοσοφθορισμό, από το μικροσκόπιο 

επεξεργάστηκαν με τη χρήση του προγράμματος ImageJ διευκολύνοντας την εξαγωγή 

αξιόπιστων αποτελεσμάτων. Οι ψηφιακές εικόνες αποτελούνται από εικονοστοιχεία (pixel) 

τα οποία παρέχουν πληροφορίες για κάποια περιοχή ενδιαφέροντος και κατά συνέπεια όσο 

πιο καλή η ανάλυση στην οποία αποθηκεύονται οι φωτογραφίες τόσο μεγαλύτερος αριθμός 

πληροφοριών εξάγεται. Με την ανάλυση των εικόνων μετρήθηκαν η ένταση σήματος, οι 

αποστάσεις και τα μεγέθη των περιοχών στους υπό μελέτη ιστούς για κάθε πειραματική 

συνθήκη ξεχωριστά.  

Για τη μέτρηση αποστάσεων σε μια φωτογραφία ενδιαφέροντος στο ImageJ αρχικά πρέπει 

να οριστεί το είδος της επιθυμητής μέτρησης που θα γίνει: μέτρηση αποστάσεων (π. χ. πάχος 

στοιβάδας αμφιβληστροειδή) στο παράθυρο του Set Measurements (Analyze>Set 

Measurements) σβήνοντας όλες τις επιλογές εκτός από την επιλογή Display Label και την 

επιλογή Add to overlay. Ακολούθως: 

1.  Ενεργοποίηση του Διαχειριστή των Περιοχών Ενδιαφέροντος (ROI Manager : 

Analyze>Tools>ROI Manager).  
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2.  Επιλογή της περιοχή (πάχος στοιβάδας) που θα μετρηθεί με το Εργαλείο Ευθείας 

Γραμμής (Straight).  

3.  Ονομασία της περιοχής (Edit>Selection>Properties).  

4.  Προσθήκη της περιοχής ενδιαφέροντος στο ROI Manager (Add [t] στο παράθυρο του 

ROI Manager).  

5. Αφού ολοκληρωθούν όλες οι επιθυμητές μετρήσεις σε μία φωτογραφία (π. χ. για το 

πάχος στοιβάδων αμφιβληστροειδή: All, ONL, INL, IPL) τότε αποθηκεύεται ως tiff με 

άλλο όνομα (File>Save As π. χ. Όνομα Φωτογραφίας_length. tiff). Η καινούργια 

φωτογραφία θα περιέχει ένα πρόσθετο επίπεδο (Overlay) με τις μετρήσεις.  

6.  Ο πίνακας των αποτελεσμάτων (Results) μπορεί να μεταφερθεί στο Excel ή σε 

κάποιο άλλο στατιστικό πρόγραμμα επιλέγοντας όλες της μετρήσεις που έγιναν στο 

ROI Manager (Ctrl+A) και πατώντας Ctrl+m (ή Analyze>Measure ή Measure στο 

παράθυρο του ROI Manager).  

7.  Την επόμενη φορά που θα ανοίξει οποιαδήποτε φωτογραφία που έχει πρόσθετο 

επίπεδο μπορεί να προστεθεί το περιεχόμενο του επιπέδου στο ROI Manager 

πατώντας: Image>Overlay>To ROI Manager.  

Σε κάθε φωτογραφία ορίζεται και προστίθεται η κλίμακα από το μικροσκόπιο και το φακό με 

τα οποία έχουν τραβηχτεί οι προς ανάλυση φωτογραφίες με τα εξής βήματα: 

1. Φωτογράφιση της κλίμακας στο χρησιμοποιούμενο μικροσκόπιο και φακό .  

2.  Άνοιγμα της φωτογραφίας της κλίμακας με το ImageJ και τοποθέτηση μιας ευθείας 

γραμμή με το Εργαλείο Ευθείας γραμμής (Straight) πάνω στην κλίμακα.  

3. Μεταφορά του αποτελέσματος της μέτρησης στο παράθυρο Ορισμού Κλίμακας (Set 

Scale) πατώντας Analyze>Set Scale.  

4. Στο ίδιο παράθυρο συμπληρώνονται και τα στοιχεία: απόσταση που μετρήσατε 

(Known distance), και μονάδα μέτρησης μήκους (Unit of length).  

5.  Αν επιθυμείται να τοποθετηθεί η κλίμακα σε μια φωτογραφία τότε πηγαίνετε 

Analyze>Tools>Scale bar όπου μπορεί να καθοριστεί το μέγεθος, η θέση που θα 

εμφανιστεί στη φωτογραφία, το χρώμα της κ. α.  

Για την ανάλυση της έντασης σήματος μια σε μια φωτογραφία ενδιαφέροντος στο ImageJ 

αρχικά πρέπει να οριστεί το είδος της επιθυμητής μέτρησης που θα γίνει: (ανάλυση έντασης 

σήματος σε μια περιοχή ενός ιστού ή σε ένα κύτταρο) στο παράθυρο του Set Measurements 

(Analyze>Set Measurements) ενεργοποιώντας τις επιλογές Area, Mean grey value, Standard 

deviation, Mean & max grey value, Display Label και Add to overlay. Ακολούθως: 

1.  Ενεργοποίηση του Διαχειριστή των Περιοχών Ενδιαφέροντος (ROI Manager : 

Analyze>Tools>ROI Manager).  

2.  Επιλογή της επιθυμητής προς μέτρηση περιοχής με το Εργαλείο Πολυγωνικής 

Επιλογής (Polygonal selection).  

3.  Ονομασία της περιοχής: Ctrl+y (ή Edit>Selection>Properties).  
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4.  Προσθήκη της περιοχής στο ROI Manager: Ctrl+t (ή Add [t] στο παράθυρο του ROI 

Manager).  

5. Αφού γίνουν όλες οι επιθυμητές μετρήσεις σε μια φωτογραφία (π. χ. για τον 

αμφιβληστροειδή ένταση σήματος στις περιοχές: All, ONL, IPL, INL, IPL) τότε 

αποθηκεύεται ως tiff με άλλο όνομα (File>Save As π. χ. Όνομα 

Φωτογραφίας_Intensity. tiff).  

6.  Ο πίνακας των αποτελεσμάτων μπορεί να μεταφερθεί (Results: Window>Results) στο 

Excel ή σε άλλο στατιστικό πρόγραμμα επιλέγοντας όλες οι μετρήσεις που έγιναν στο 

ROI Manager (Ctrl+a) και πατώντας Ctrl+m.  

7.  Την επόμενη φορά που θα ανοίξει οποιαδήποτε φωτογραφία με πρόσθετο επίπεδο 

μπορεί να προστεθεί το περιεχόμενο του επιπέδου στο ROI Manager πατώντας: 

Image>Overlay>To ROI Manager.  

 

 

 

 

 

 

 

 

 

ΑΠΟΤΕΛΕΣΜΑΤΑ 

ΕΠΙΔΡΑΣΗ ΜΕΤΑΒΟΛΙΚΩΝ ΠΡΟΣΒΟΛΩΝ ΣΤΟΝ ΑΜΦΙΒΛΗΣΤΡΟΕΙΔΗ ΑΡΟΥΡΑΙΟΥ 

 

Πάχος Στοιβάδων Αμφιβληστροειδή Αρουραίου Υπό Φυσιολογικές Συνθήκες 

Για τον προσδιορισμό του πάχους των στοιβάδων του αμφιβληστροειδούς υπό φυσιολογικές 

πειραματικές συνθήκες (92 λεπτά υπεδιάχυσης του ιστού σε O2 και γλυκόζη με ροή 1,2 

ml/min) εφαρμόστηκε η χρώση Cresyl Violet και εξαγωγή των αποτελεσμάτων με τη χρήση 

του προγράμματος Prism και της στατιστικής ανάλυσης t-test (Εικόνα 15Α). Υπό φυσιολογικές 

συνθήκες το πάχος κατά μέσο όρο στην Εξωτερική Κοκκώδη στοιβάδα είναι 46 μm, στην 

Εσωτερική Κοκκώδη στοιβάδα είναι 22 μm και στην Εσωτερική Δικτυωτή στοιβάδα είναι 42 

μm (Εικόνα 15Β).  

 

 

  

 

Πάχος Στοιβάδων Αμφιβληστροειδή Αρουραίου

υπό Φυσιολογικές Συνθήκες

ΕξΚ ΕσΚ ΕσΔ

0

25

50

75

100

Στοιβάδες Αμφιβληστροειδή

Π
ά

χ
ο
ς
 (

μ
m

)

B 

ΕξΚ 

ΕσΚ 

ΕσΔ 

ΕξΔ 

Α 



35 
 

 

  

 

 

 

 

 

 

 

Εικόνα 15. Πάχος Στοιβάδων Αμφιβληστροειδή Αρουραίου Υπό Φυσιολογικές Συνθήκες 

(Α) Χρώση Cresyl Violet σε αμφιβληστροειδή αρουραίου μετά από 92 λεπτά υπεδιάχυσης του ιστού σε 
φυσιολογικές συνθήκες (O2, γλυκόζη) με ροή 1,2 ml/min. Διακρίνονται οι στοιβάδες του ιστού: ΕξΚ : 
Εξωτερική κοκκώδης στοιβάδα, ΕξΔ: Εξωτερική δικτυωτή στοιβάδα, ΕσΚ: Εσωτερική κοκκώδη 
στοιβάδα, ΕσΔ: Εσωτερική δικτυωτή στοιβάδα, ΓΚ: Στοιβάδα γαγγλιακών κυττάρων. Κλίμακα: 100 μm, 
Μεγέθυνση: x10 (Β) Μέτρηση του πάχους της Εξωτερικής πυρηνικής στοιβάδας, της Εσωτερικής 
πυρηνικής στοιβάδας και της Εσωτερικής δικτυωτής στοιβάδας αμφιβληστρειδή αρουραίου υπό 
φυσιολογικές συνθήκες (n=6).  
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Μεταβολή του Πάχους του Αμφιβληστροειδή Αρουραίου Υπό την Επίδραση 

Μεταβολικών Προσβολών 

Για τον προσδιορισμό της μεταβολής του πάχους των στοιβάδων του αμφιβληστροειδούς 

υπό μεταβολικές προσβολές (υποξία, ισχαιμία και υπογλυκαιμία μετά από 92 λεπτά 

υπερδιάχυσης του ιστού με ροή 1,2 ml/min), εφαρμόσθηκε η ανάλυση εικόνας σε τομές 

χρωσμένες με Cresyl Violet. Σε φυσιολογικές συνθήκες το πάχος των στοιβάδων συνολικά 

ήταν κατά μέσο όρο 118,82 + 7,48 μm. Επίσης κατά μέσο όρο, στην ισχαιμία ισούται με 

157,25 + 7,49 μm, στην υποξία ισούται με 139,07 + 7,06 μm και στην υπογλυκαιμία ισούται 

με 140,03 + 5,20 μm (n=6). Παρατηρήθηκε στατιστικώς σημαντική αλλαγή του πάχους του 

αμφιβληστροειδούς (Ρ<0,01) στην περίπτωση της ισχαιμίας ενώ στις υπόλοιπες μεταβολικές 

προσβολές δεν παρατηρήθηκε κάτι αντίστοιχο  (Εικόνα 16 E).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 16. Μεταβολή του Πάχους του Αμφιβληστροειδή Αρουραίου Υπό την Επίδραση Μεταβολικών 
Προσβολών 

(Α-D) Χρώση Cresyl Violet σε τομές αμφιβληστροειδούς αρουραίου μετά από 92 λεπτά υπεδιάχυσης 
του ιστού σε φυσιολογικές συνθήκες (O2, γλυκόζη) και συνθήκες μεταβολικής προσβολής (Ισχαιμία: 
ΝO2 και σουκρόζη, Υποξία: ΝO2 και γλυκόζη, Υπογλυκαιμία: O2 και σουκρόζη). Α) Φυσιολογικές 
συνθήκες Β) Ισχαιμία C) Υποξία D) Υπογλυκαιμία. Κλίμακα: 100 μm, Μεγέθυνση: x10. 
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Εικόνα 16. Μεταβολή του Πάχους του Αμφιβληστροειδούς Αρουραίου Υπό την Επίδραση Μεταβολικών 
Προσβολών 

Σύγκριση του πάχους του αμφιβληστροειδούς στις διάφορες μεταβολικές συνθήκες **: P<0, 01 (n=6). 
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Μεταβολή του Πάχους της Εξωτερικής Κοκκώδους Στοιβάδας Αμφιβληστροειδούς 

Αρουραίου Υπό την Επίδραση Μεταβολικών Προσβολών 

Η ανάλυση των τομών χρωσμένων με Cresyl Violet κατέδειξε τη μεταβολή του πάχους της 

εξωτερικής κοκκώδους στοιβάδας για κάθε μεταβολική προσβολή μετά από 92 λεπτά 

υπερδιάχυσης. Σε φυσιολογικές συνθήκες το πάχος της στοιβάδας ήταν κατά μέσο όρο 46,46 

+ 4,23 μm. Επίσης κατά μέσο όρο, στην ισχαιμία βρέθηκε να είναι με 61,46 + 2,94 μm, στην 

υποξία 51,38 + 2,70 μm και στην υπογλυκαιμία 55,19 + 2,52 μm (n=6). Όπως παρατηρήθηκε, 

η ισχαιμία προκάλεσε στατιστικώς σημαντική αύξηση του πάχους της στοιβάδας (P< 0.01) σε 

σχέση με τις φυσιολογικές συνθήκες, ενώ δεν παρατηρήθηκε κάποια στατιστικώς σημαντική 

αλλαγή στις άλλες περιπτώσεις (Εικόνα 17). 

 

 

Εικόνα 17. Σύγκριση του πάχους της Εξωτερικής Κοκκώδους Στοιβάδας του αμφιβληστροειδούς σε 
διάφορες μεταβολικές συνθήκες **: P<0, 01 (n=6) .  
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Μεταβολή του Πάχους της Εσωτερικής Κοκκώδους Στοιβάδας Αμφιβληστροειδούς 

Αρουραίου Υπό την Επίδραση Μεταβολικών Προσβολών 

Η ανάλυση των τομών χρωσμένων με Cresyl Violet κατέδειξε τη μεταβολή του πάχους της 

εσωτερικής κοκκώδους στοιβάδας για κάθε μεταβολική προσβολή μετά από 92 λεπτά 

υπερδιάχυσης. Σε φυσιολογικές συνθήκες το πάχος της στοιβάδας κατά μέσο όρο αντιστοιχεί 

σε 22,27 + 1,53 μm. Επίσης κατά μέσο όρο, στην ισχαιμία βρέθηκε να είναι 28,25 + 1,40 μm, 

στην υποξία 26,32 + 1,64 μm και στην υπογλυκαιμία 27,00 + 2,16 μm (n=6). Στην περίπτωση 

της ισχαιμίας παρατηρήθηκε στατιστικώς σημαντική αλλαγή (P<0,05) στο πάχος της 

Εσωτερικής κοκκώδους στοιβάδας σε σύγκριση με τις υπόλοιπες μεταβολικές καταστάσεις 

(Εικόνα 18). 

 

 

Εικόνα 18. Σύγκριση του πάχους της Εσωτερικής Κοκκώδους Στοιβάδας του αμφιβληστροειδούς σε 
διάφορες μεταβολικές συνθήκες *: P<0,05 (n=6). 
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Μεταβολή του Πάχους της Εσωτερικής Δικτυωτής Στοιβάδας Αμφιβληστροειδούς 

Αρουραίου Υπό την Επίδραση Μεταβολικών Προσβολών 

Η ανάλυση των τομών χρωσμένων με Cresyl Violet κατέδειξε τη μεταβολή του πάχους της 

Εσωτερικής Δικτυωτής Στοιβάδας για κάθε μεταβολική προσβολή μετά από 92 λεπτά 

υπερδιάχυσης. Σε φυσιολογικές συνθήκες το πάχος της στοιβάδας κατά μέσο όρο είναι 42,45 

+ 2,49 μm. Κατά μέσο όρο το πάχος βρέθηκε να είναι: στην ισχαιμία 54,30 + 3,97 μm, στην 

υποξία 44,41 + 3,36 μm και στην υπογλυκαιμία 49,40 + 2,54 μm (n=6). Στην περίπτωση της 

ισχαιμίας παρατηρείται στατιστικά σημαντική αύξηση του πάχους της Εσωτερικής Δικτυωτής 

Στοιβάδας (Ρ<0,05), ενώ δεν παρατηρείται κάτι αντίστοιχο στις υπόλοιπες μεταβολικές 

προσβολές (Εικόνα 19). 

 

 

Εικόνα 19. Σύγκριση του πάχους της Εσωτερικής Δικτυωτής Στοιβάδας του αμφιβληστροειδούς σε 
διάφορες μεταβολικές συνθήκες *: P<0,05 (n=6). 
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Χρώση των Σωματιδίων Nissl στον Αμφιβληστροειδούς Αρουραίου Υπό Φυσιολογικές 

Συνθήκες 

Η ανάλυση του ιστού που είχε χρωσθεί με Cresyl Violet για τα σωμάτια Nissl στον 

αμφιβληστροειδή αρουραίου υπό φυσιολογικές συνθήκες έδειξε στατιστικώς σημαντική (P< 

0,01) μειωμένη ένταση σήματος στην Εσωτερική κοκκώδη στοιβάδα συγκριτικά με την 

Εξωτερική κοκκώδη στοιβάδα (Εικόνα 20Α). Στην περίπτωση της εκτιμώμενης ολικής χρώσης 

των σωματιδίων Nissl με Cresyl Violet έδειξε στατιστικώς σημαντική (P< 0,01) μειωμένη 

ένταση σήματος στην Εσωτερική κοκκώδη στοιβάδα συγκριτικά με την Εξωτερική κοκκώδη 

στοιβάδα (Εικόνα 20B). 

 

 

Εικόνα 20. Χρώση των Σωματιδίων Nissl στον Αμφιβληστροειδή Αρουραίου Υπό Φυσιολογικές Συνθήκες. 
Α) Ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet, **: P<0,01 (n=6)  B) 
Εκτιμώμενη ολική χρώση των σωματιδίων Nissl ***: P<0,001  (n=6). 
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην Εξωτερική 

Κοκκώδη Στοιβάδα Αμφιβληστροειδούς Αρουραίου 

Η ανάλυση του ιστού που είχε χρωσθεί με Cresyl Violet για τα σωμάτια Nissl στην Εξωτερική 

Κοκκώδη Στοιβάδα του αμφιβληστροειδούς αρουραίου υπό την επίδραση μεταβολικών 

προσβολών δεν έδειξε καμία στατιστικώς σημαντική αλλαγή στην ένταση σήματος. Σε 

φυσιολογικές συνθήκες η ένταση σήματος της στοιβάδας ήταν κατά μέσο όρο 124,79 + 7,44 

μm. Επίσης κατά μέσο όρο, στην ισχαιμία 118,51 + 5,22 μm, στην υποξία 118,60 + 4,55 μm 

και στην υπογλυκαιμία 119,97 + 6,68 μm (n=6), (Εικόνα 21Α). Στην περίπτωση της 

εκτιμώμενης ολικής χρώσης των σωματιδίων Nissl με Cresyl Violet έδειξε στατιστικώς 

σημαντική (P< 0,01) αύξηση της έντασης σήματος στην Εξωτερική κοκκώδη Στοιβάδα κατά 

την ισχαιμία συγκριτικά με τις υπόλοιπες μεταβολικές προσβολές (Εικόνα 21B).  

 

 

Εικόνα 21.Α) Ένταση σήματος των σωματιδίων Nissl της Εξωτερικής Κοκκώδους στοιβάδας μετά από 
χρώση τους με Cresyl violet B) Εκτιμώμενη ολική χρώση των σωματιδίων Nissl **: P<0,01 (n=6).   
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην Εσωτερική 

Κοκκώδη Στοιβάδα Αμφιβληστροειδούς Αρουραίου 

Η ανάλυση του ιστού που είχε χρωσθεί με Cresyl Violet για τα σωμάτια Nissl στην Εσωτερική 

Κοκκώδη Στοιβάδα του αμφιβληστροειδούς αρουραίου υπό την επίδραση μεταβολικών 

προσβολών δεν έδειξε καμία στατιστικώς σημαντική αλλαγή στην ένταση σήματος. Σε 

φυσιολογικές συνθήκες η ένταση σήματος της στοιβάδας ήταν κατά μέσο όρο 82,45 + 6,16 

μm. Επίσης κατά μέσο όρο, στην ισχαιμία 85,76 + 6,26 μm, στην υποξία 78,33 + 7,81 μm και 

στην υπογλυκαιμία 80,18 + 7,00 μm (n=6), (Εικόνα 22Α). Στην περίπτωση της εκτιμώμενης 

ολικής χρώσης των σωματιδίων Nissl με Cresyl Violet επίσης δεν έδειξε καμία στατιστικώς 

σημαντική αλλαγή της έντασης σήματος στις μεταβολικές προσβολές (Εικόνα 22B). 

 

 

Εικόνα 22. Α) Ένταση σήματος των σωματιδίων Nissl της Εσωτερικής Κοκκώδους στοιβάδας μετά από 

χρώση τους με Cresyl violet B) Εκτιμώμενη ολική χρώση των σωματιδίων (n=6).   
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Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα της nNOS στον 

Αμφιβληστροειδή Αρουραίου 

Διενεργήθηκε ανοσοϊστοχημική χρώση του αμφιβληστροειδούς με τη χρήση anti-nNOS ως 

πρώτο αντίσωμα με σκοπό τον εντοπισμό και την εκτίμηση της έκφρασης της νευρωνικής 

συνθάσης σε φυσιολογικές συνθήκες και στις μεταβολικές καταστάσεις (ισχαιμία, υποξία, 

υπογλυκαιμία). Κατά την ισχαιμία παρατηρείται έντονη έκφραση σε κυτταρικά σώματα της 

Εσωτερικής Κοκκώδους στοιβάδας. Σε φυσιολογικές συνθήκες και στις άλλες δύο 

μεταβολικές καταστάσεις δεν παρατηρείται κάτι αντίστοιχο (n=3), (Εικόνα 23). 

 

 
Εικόνα 23.  Ανοσοϊστοχημικός εντοπισμός της nNOS σε αμφιβληστροειδή αρουραίου. Πάνω: 

Φθορισμός της nNOS και κάτω: φθορισμός της DAPI (n=3). Α) Φυσιολογικές συνθήκες Β) Ισχαιμία C) 

Υποξία D) Υπογλυκαιμία. Διακρίνονται οι στοιβάδες του ιστού: ΕξΚ : Εξωτερική κοκκώδης στοιβάδα, 

ΕξΔ: Εξωτερική δικτυωτή στοιβάδα, ΕσΚ: Εσωτερική κοκκώδη στοιβάδα, ΕσΔ: Εσωτερική δικτυωτή 

στοιβάδα, ΓΚ: Στοιβάδα γαγγλιακών κυττάρων. Κλίμακα: 50 μm, Μεγέθυνση: x40. 

50μm 
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Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα της eNOS στον 

Αμφιβληστροειδή Αρουραίου 

Διενεργήθηκε ανοσοϊστοχημική χρώση του αμφιβληστροειδούς με τη χρήση anti-eNOS ως 

πρώτο αντίσωμα με σκοπό τον εντοπισμό και την εκτίμηση της έκφρασης της ενδοθηλιακής 

συνθάσης σε φυσιολογικές συνθήκες και στις μεταβολικές καταστάσεις (ισχαιμία, υποξία, 

υπογλυκαιμία). Σε φυσιολογικές συνθήκες εντοπίζεται η παρουσία eNOS σε τριχοειδή αγγεία 

στον έσω (ΕσΚ, ΕσΔ, ΓΚ) αμφιβληστροειδή και όχι στο εξωτερικό τμήμα. Δεν υπάρχουν 

εμφανείς διαφορές μεταξύ των διάφορων μεταβολικών συνθηκών στην έκφραση της eNOS 

(n=3), (Εικόνα 24). 

 

 

Εικόνα 24.  Ανοσοϊστοχημικός εντοπισμός της eNOS σε αμφιβληστροειδή αρουραίου. Πάνω: 
Φθορισμός της nNOS και κάτω: φθορισμός της DAPI (n=3). Α) Φυσιολογικό Β) Ισχαιμία C) Υποξία D) 
Υπογλυκαιμία. Διακρίνονται οι στοιβάδες του ιστού: ΕξΚ : Εξωτερική κοκκώδης στοιβάδα, ΕξΔ: 
Εξωτερική δικτυωτή στοιβάδα, ΕσΚ: Εσωτερική κοκκώδης στοιβάδα, ΕσΔ: Εσωτερική δικτυωτή 
στοιβάδα, ΓΚ: Στοιβάδα γαγγλιακών κυττάρων. Κλίμακα: 100 μm, Μεγέθυνση: x10.  

A B 

C D 



46 
 

Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα του GABA στον 

Αμφιβληστροειδή Αρουραίου 

Διενεργήθηκε ανοσοϊστοχημική χρώση του αμφιβληστροειδούς με τη χρήση αντισώματος 

έναντι του GABA ως πρώτο αντίσωμα με σκοπό τον εντοπισμό και την εκτίμηση της 

έκφρασης σε φυσιολογικές συνθήκες και στις μεταβολικές καταστάσεις (ισχαιμία, υποξία, 

υπογλυκαιμία). Σε φυσιολογικές συνθήκες εντοπίζεται η παρουσία GABA κυρίως στον έσω 

(ΕσΚ, ΕσΔ, ΓΚ) αμφιβληστροειδή και όχι στο εξωτερικό τμήμα. Στην ισχαιμία η ένταση του 

σήματος φτάνει σε μηδενικό επίπεδο ενώ στην υποξία και υπογλυκαιμία μειώνεται η ένταση 

σήματος αλλά σε μικρότερο βαθμό συγκριτικά με την ισχαιμία. Στην υποξία διακρίνονται 

κάποια κυτταρικά σώματα των νευρώνων (n=3), (Εικόνα 25). 

 

 
Εικόνα 25. Ανοσοϊστοχημικός εντοπισμός του GABA σε αμφιβληστροειδή αρουραίου. Πάνω: 
Φθορισμός του GABA σε μεγένθυνση x10  και κάτω: φθορισμός GABA σε μεγέθυνση x40, (n=3). Α) 
Φυσιολογικές συνθήκες Β) Ισχαιμία C) Υποξία D) Υπογλυκαιμία . Διακρίνονται οι στοιβάδες του 
ιστού: ΕξΚ: Εξωτερική κοκκώδης στοιβάδα, ΕξΔ: Εξωτερική δικτυωτή στοιβάδα, ΕσΚ: Εσωτερική 
κοκκώδης στοιβάδα, ΕσΔ: Εσωτερική δικτυωτή στοιβάδα, ΓΚ: Στοιβάδα γαγγλιακών κυττάρων. 
Κλίμακα: 100 μm, Μεγέθυνση: x10.  

100μm 
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ΕΠΙΔΡΑΣΗ ΜΕΤΑΒΟΛΙΚΩΝ ΠΡΟΣΒΟΛΩΝ ΣΤΟΝ ΙΠΠΟΚΑΜΠΟ ΑΡΟΥΡΑΙΟΥ 

Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στον 

Ιππόκαμπο Αρουραίου υπό Φυσιολογικές συνθήκες 

Η χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο συνέβαλε στην απεικόνιση της 

μορφολογίας του ιστού καθώς βάφονται τα πυραμιδικά κύτταρα στα διάφορα πεδία του 

ιππόκαμπου και τα κοκκώδη κύτταρα της οδοντωτής έλικας (Εικόνα 26). 

 

 

Εικόνα 26. Χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο υπό φυσιολογικές συνθήκες 

(n=6). 
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στον 

Ιππόκαμπο Αρουραίου υπό Ισχαιμική επίδραση 

 

 

 

Εικόνα 27. Χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο υπό την επίδραση ισχαιμίας 

(n=6). Δεν παρατηρείται κάποια διαφορά συγκριτικά με τις φυσιολογικές συνθήκες. 
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στον 

Ιππόκαμπο Αρουραίου υπό την επίδραση Υπογλυκαιμίας 

 

 

 

Εικόνα 28. Χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο υπό την επίδραση υπογλυκαιμίας 

(n=6). Δεν παρατηρείται κάποια διαφορά συγκριτικά με τις φυσιολογικές συνθήκες. 

 

  



50 
 

Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στον 

Ιππόκαμπο Αρουραίου υπό την επίδραση Υποξίας 

 

 

Εικόνα 29. Χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο υπό την επίδραση υποξίας (n=6). 

Δεν παρατηρείται κάποια διαφορά συγκριτικά με τις φυσιολογικές συνθήκες. 
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην CA3 

Περιοχή Ιππόκαμπου Αρουραίου 

Η χρώση Cresyl Violet για τα σωμάτια Nissl στον ιππόκαμπο συνέβαλε στην απεικόνιση της 

μορφολογίας του ιστού και στην εκτίμηση των μορφολογικών διαφορών μεταξύ του 

φυσιολογικού και των μεταβολικών προσβολών (ισχαιμία, υποξία, υπογλυκαιμία). 

Παρατηρείται εμφανής αλλαγή στην μορφολογία των πυραμιδικών κυττάρων της CA3 

περιοχής ιδιαίτερα στην περίπτωση της ισχαιμίας και της υπογλυκαιμίας. Το φαινόμενο αυτό 

σύμφωνα με τη βιβλιογραφία ονομάζεται “Dark neurons” και απεικονίζει μία τοπική 

μορφολογική αλλαγή που υφίσταται στους νευρώνες μετά από οξεία μεταβολική προσβολή 

(Ooigawa και συν., 2006), (Εικόνα 30). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 30. Χρώση Cresyl violet  σε τομές ιππόκαμπου (CA3 περιοχή), (n=6). Α) Φυσιολογικές συνθήκες 

Β) Ισχαιμία C) Υποξία D) Υπογλυκαιμία. Or: Oriens layer hippocampus, Py: Pyramidal cell layer 

hippocampus, Rad: Radiatum layer hippocampus.  
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην CA1 

Περιοχή Ιππόκαμπου Αρουραίου 

Η χρώση Cresyl Violet για τα σωμάτια Nissl στην περιοχή CA1 του ιππόκαμπου έδειξε 

μορφολογικές διαφορές μεταξύ του φυσιολογικού και των μεταβολικών προσβολών 

(ισχαιμία, υποξία, υπογλυκαιμία). Παρατηρείται εμφανής αλλαγή στην μορφολογία των 

πυραμιδικών κυττάρων της CA1 περιοχής ιδιαίτερα στην περίπτωση της ισχαιμίας και της 

υπογλυκαιμίας. Η ένταση του σήματος φαίνεται να μειώνεται υπό την επίδραση της 

ισχαιμίας και της υποξίας σε σύγκριση με το φυσιολογικό και την υπογλυκαιμία που 

εμφανίζουν πιο έντονη ένταση σήματος (Εικόνα 31). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 31. Χρώση Cresyl violet  σε τομές ιππόκαμπου (CA1 περιοχή), (n=6). Α) Φυσιολογικές συνθήκες 

Β) Ισχαιμία C) Υποξία D) Υπογλυκαιμία. Or: Oriens layer hippocampus, Py: Pyramidal cell layer 

hippocampus, Rad: Radiatum layer hippocampus.   
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην Οδοντωτή 

Έλικα Ιππόκαμπου Αρουραίου 

Η ανάλυση του ιστού που χρώσθηκε με Cresyl Violet για τα σωμάτια Nissl στην Οδοντωτή 

Έλικα του ιππόκαμπου δεν έδειξε μορφολογικές διαφορές μεταξύ του φυσιολογικού και των 

μεταβολικών προσβολών (ισχαιμία, υποξία, υπογλυκαιμία), (Εικόνα 32). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 32. Χρώση Cresyl violet  σε τομές ιππόκαμπου (Οδοντωτή Έλικα), (n=6). Α) Φυσιολογικό Β) 

Ισχαιμία C) Υποξία D) Υπογλυκαιμία. MoDG: Molecular layer Dentate gyrus, GrDG: Granular layer 

Dentate gyrus, PoDG: Polymorph layer Dentate gyrus. 
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ΣΥΖΗΤΗΣΗ 
 

Η εγκεφαλική ισχαιμία είναι μια παθολογική κατάσταση στην οποία η ροή του αίματος στον 

εγκέφαλο είναι ανεπαρκής για να καλύψει αυτές τις μεταβολικές απαιτήσεις, προκαλώντας 

απώλεια της νευρωνικής λειτουργίας και βιωσιμότητας. 

Με βάση τα αποτελέσματα επί της μορφολογίας των δύο ιστών που εξετάσθηκαν στην 

παρούσα μελέτη, του αμφιβληστροειδούς και του ιππόκαμπου, δεν διαπιστώθηκε κάποια 

στατιστικά σημαντική αλλαγή στις διάφορες μεταβολικές4 συνθήκες που εξετάσθηκαν. Στην 

περίπτωση του αμφιβληστροειδούς αξιοσημείωτο αποτελεί μία σχετική αύξηση του πάχους 

της Εξωτερικής Κοκκώδους Στοιβάδας, αλλά και αύξηση της έντασης σήματος των 

σωματιδίων Nissl της Εξωτερικής Κοκκώδους Στοιβάδας μετά από την επίδραση της 

ισχαιμίας. Η αύξηση της έντασης σήματος των σωματιδίων Nissl μπορεί να σχετίζεται με την 

παρουσία των “Dark neurons”. Η έντονη αυτή χρώση των σωματιδίων Nissl είναι 

χαρακτηριστική των περιοχών εγκεφαλικού τραύματος και συμπίπτει με τις περιοχές που 

μελλοντικά παρατηρείται κυτταρικός θάνατος (Ooigawa και συν., 2006). 

Στην περίπτωση του ιππόκαμπου διακρίνεται αλλαγή στη μορφολογία των πυραμιδικών 

νευρώνων της CA3 περιοχής λόγω της εμφάνισης του φαινομένου “Dark neurons” ιδιαίτερα 

στην ισχαιμία, αλλά και στην υπογλυκαιμία. Η διαπίστωση αυτών των αλλαγών στην 

περίπτωση της ισχαιμίας δικαιολογούν το γεγονός πως όταν υπάρχει έλλειψη οξυγόνου και 

γλυκόζης ο ιστός δεν μπορεί να καλύψει τις ενεργειακές του ανάγκες καθώς οι διαδικασίες 

παραγωγής τριφωσφορικής αδενοσίνης (ATP) στηρίζονται στην παρουσία οξυγόνου και 

γλυκόζης, και ιδιαίτερα στην παρουσία οξυγόνου. Στην υπογλυκαιμία λόγω της παρουσίας 

οξυγόνου αλλά και των βραχυπρόθεσμων εναλλακτικών μεταβολικών υποστρωμάτων, το 

κύτταρο παράγει ενέργεια μέχρι την εξάλειψη των υποστρωμάτων αυτών και έπειτα 

εμφανίζονται ανεπιθύμητα αποτελέσματα. Η υποξία οδηγεί κυρίως σε αλλαγές της 

φυσιολογικής λειτουργίας των νευρώνων χωρίς αυτό να σημαίνει θάνατο των νευρικών 

κυττάρων.  

 

Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα της nNOS στον 

Αμφιβληστροειδή Αρουραίου 

Η έκφραση της νευρωνικής μορφής της συνθάσης του ΝΟ, στον αμφιβληστροειδή 

εντοπίζεται στα κυτταρικά σώματα σπάνιων βραχύινων κυττάρων στην εσωτερική κοκκώδη 

στοιβάδα καθώς και στις αποφύσεις τους που σχηματίζουν 3 υποστοιβάδες στην εσωτερική 

δικτυωτή στοιβάδα και διατρέχουν όλο το μήκος του αμφιβληστροειδούς. Στα πειράματα 

μας παρατηρήθηκε έκφραση μόνο σε κυτταρικά σώματα της Εσωτερικής Κοκκώδους 

στοιβάδας και όχι στις υπόλοιπες στοιβάδες. Επιβεβαίωση των παρατηρήσεών μας θα ήταν 

καλό να γίνει με εκτίμηση της έκφρασης του ενζύμου με τη βοήθεια ανοσοστυπώματος κατά 

Western Blot. 
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 Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα της eNOS στον 

Αμφιβληστροειδή Αρουραίου 

Όπως ήταν αναμενόμενο, σε φυσιολογικές συνθήκες παρατηρείται η παρουσία eNOS σε 

τριχοειδή αγγεία στον έσω (ΕσΚ, ΕσΔ, ΓΚ) αμφιβληστροειδή καθώς το εξωτερικό τμήμα του 

αμφιβληστροειδούς δέχεται θρεπτικά συστατικά από τον χοριοειδή χιτώνα. Δεν υπάρχουν 

εμφανείς διαφορές μεταξύ των διαφόρων μεταβολικών συνθηκών στην έκφραση της eNOS.  

Καλύτερη εκτίμηση της έκφρασης της eNOS και της nNOS θα γινόταν με ανοσοϊστοχημεία 

free floating ολόκληρου του αμφιβληστροειδούς και με κατάλληλη τοποθέτηση του ιστού σε 

συνεστιακό μικροσκόπιο έτσι ώστε να είναι πιο ευδιάκριτη η οποιαδήποτε διαφορά στην 

έκφραση των εν λόγω ενζύμων. Ένας επιπλέον περιοριστικός παράγοντας της παρούσας 

μελέτης αποτελεί και η μικρή χρονική διάρκεια της πειραματικά επαγόμενης μεταβολικής 

προσβολής στον ιστό. 

ΝΟ 

Το οξείδιο του αζώτου (NO: nitric oxide) αποτελεί ένα ενδοκυτταρικό αλλά και εξωκυτταρικό 

αέριο σηματοδοτικό μόριο με μικρό χρόνο ημιζωής. Παράγεται από το ένζυμο συνθάση του 

οξειδίου του αζώτου (NOS: Nitric Oxide Synthases) όταν αυτό ενεργοποιηθεί με αύξηση του 

ενδοκυτταρικού Ca2+. Υπάρχουν τρεις διαφορετικές ισομορφές NOS: 

- Η νευρωνική NOS (nNOS: Neuronal NOS) που εκφράζεται στους νευρώνες και 

εμπλέκεται στη ρύθμιση φυσιολογικών λειτουργιών όπως μνήμη, μάθηση αλλά και 

στη μακροπρόθεσμη ρύθμιση της συναπτικής διαβίβασης. 

- Η ενδοθηλιακή NOS (eNOS: Endothelial NOS) που εκφράζεται σε ενδοθηλιακά 

κύτταρα και διεγείρει την χαλάρωση του ενδοθυλίου προωθώντας την 

αγγειοδιαστολή. 

- H επαγώγιμη NOS (iNOS: Inducible NOS) που εκφράζεται σε ορισμένα κύτταρα του 

ανοσοποιητικού συστήματος, τα μακροφάγα και τα ουδετερόφιλα, συμβάλλοντας 

στην ανοσολογική απόκριση του οργανισμού. 

Κάποιοι νευρώνες εκτός από την nNOS εκφράζουν eNOS και iNOS. Το NO ανάλογα με τη 

συγκέντρωση στην οποία βρίσκεται προκαλεί νευροπροστατευτικά (< 1μΜ) αλλά και 

νευροτοξικά (> 1μΜ)  αποτελέσματα. Σε νευροεκφυλιστικές ασθένειες παρατηρείται 

αυξημένη συγκέντρωση του ΝΟ με αποτέλεσμα τη νιτροσυλίωση πρωτεϊνών και τελικά τον 

κυτταρικό θάνατο του νευρώνα. Επίσης όταν το ΝΟ βρίσκεται σε υψηλές  συγκεντρώσεις 

ενδοκυτταρικά, σχηματίζει υπεροξονιτρώδες (ONOO -) μετά από την αντίδραση του NO με το 

υπεροξείδιο με αποτέλεσμα τον κυτταρικό θάνατο καθώς τα μιτοχόνδρια θα υποστούν 

βλάβη και το κύτταρο δεν θα τροφοδοτείται ενεργειακά (Doherty, 2011). 

Πειραματικές μελέτες αναστολής της έκφρασης της nNOS έδειξαν μικρότερη ποσοτικά 

καταστροφή του ιστού μετά από ένα πειραματικά επαγόμενο ισχαιμικό εγκεφαλικό 

επεισόδιο, οδηγώντας στο συμπέρασμα  πως η δράση της nNOS μπορεί να είναι επιζήμια για 

την επιβίωση των νευρώνων κατά τη διάρκεια της ισχαιμίας. Αντιθέτως, όταν γινόταν 

καταστολή της έκφρασης της eNOS  σε αντίστοιχη πειραματική συνθήκη τα αποτελέσματα 

έδειξαν πως οι ιστοί θα υποστούν μεγαλύτερη βλάβη από ό,τι θα συνέβαινε φυσιολογικά. 

Αυτό οδηγεί στο συμπέρασμα πως η eNOS έχει νευροπροστατευτική ιδιότητα, ενώ 

πιθανότατα η υπερπαραγωγή νευρωνικών NO οδηγεί σε νευροτοξικότητα. Για αυτό το λόγο 

μπορεί να επιλεχθεί ως μελλοντικός θεραπευτικός στόχος. Όμως, το αν τελικά το ΝΟ είναι 

επιβλαβές ή ωφέλιμο δεν έχει καθοριστεί ακόμη (Huang και συν., 1996). 
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Επίδραση Μεταβολικών Προσβολών στην Ανοσοδραστικότητα της GABA στον 

Αμφιβληστροειδή Αρουραίου 

Διενεργήθηκε ανοσοϊστοχημική χρώση του αμφιβληστροειδούς με τη χρήση anti-GABA ως 

πρώτο αντίσωμα με σκοπό τον εντοπισμό και την εκτίμηση της έκφρασης του 

νευροδιαβιβαστή σε φυσιολογικές συνθήκες και στις μεταβολικές καταστάσεις (ισχαιμία, 

υποξία, υπογλυκαιμία). Σε φυσιολογικές συνθήκες εντοπίζεται η παρουσία GABA κυρίως 

στον έσω (ΕσΚ, ΕσΔ, ΓΚ) αμφιβληστροειδή και ιδιαίτερα στα βραχύινα και οριζόντια κύτταρα 

και όχι στο εξωτερικό τμήμα. Στις μεταβολικές προσβολές βρέθηκε ότι το σήμα εξασθενεί και 

είναι σχεδόν μηδενικό πιθανώς λόγω της αυξημένης απελευθέρωσης του νευροδιαβιβαστή 

από τους νευρώνες. Στην υπογλυκαιμία και υποξία διακρίνονται κάποια κυτταρικά σώματα 

νευρώνων. 

 

 

Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην CA3 Περιοχή 

Ιππόκαμπου  Αρουραίου  

Κατά την εκτίμηση των μορφολογικών διαφορών μεταξύ του φυσιολογικού και των 

μεταβολικών προσβολών (ισχαιμία, υποξία, υπογλυκαιμία) παρατηρήθηκε εμφανής αλλαγή 

στην μορφολογία των πυραμιδικών κυττάρων της CA3 περιοχής ιδιαίτερα στην περίπτωση 

της ισχαιμίας και της υπογλυκαιμίας. Το φαινόμενο αυτό ονομάζεται “Dark neurons” και 

απεικονίζει μία μορφολογική αλλαγή που υφίσταται στους νευρώνες μετά από οξείες 

μεταβολικές προσβολές. Αυτοί οι νευρώνες διαχωρίζονται από τους φυσιολογικούς 

νευρώνες λόγω των ιδιαίτερων χαρακτηριστικών τους, μερικά από τα οποία είναι: 

 Η έντονη συμπύκνωση του κυτταροπλάσματος και του καρυοπλάσματος λόγω 

καταστροφής πρωτεϊνών του κυτταροσκελετού 

 Συσσωμάτωση της χρωματίνης του πυρήνα 

 Μείωση του αδρού ενδοπλασματικού δικτύου και των ροζέτων ριβοσωμάτων 

 Ακανόνιστο σχήμα δενδρίτων (corkscrew-like)  

 Υπερχρωματικοί νευρώνες καθώς βάφονται πιο εύκολα με χρώσεις νουκλεϊκών 

οξέων λόγω της παρουσίας ελεύθερων ριβοσωμάτων (Ooigawa και συν., 2006) 

Η εμφάνιση αυτής της μορφολογικής αλλαγής παρατηρείται σε οξείες μεταβολικές 

προσβολές των νευρώνων όπως είναι η υπογλυκαιμία και η ισχαιμία καθώς υπάρχει έλλειψη 

των δύο βασικών στοιχείων επιβίωσης του κυττάρου, το οξυγόνο και η γλυκόζη (Jortner 

2006). Παρατηρείται μείωση του αριθμού των μιτοχονδρίων σε αυτούς τους νευρώνες κάτι 

το οποίο οδηγεί στη μείωση των μιτοχονδριακών ενζύμων, αλλά και άλλων ενζύμων του 

κυτταροπλάσματος που σχετίζονται άμεσα με την παραγωγή ενέργειας  για την κάλυψη των 

ενεργειακών αναγκών και τη φυσιολογική λειτουργία των κυττάρων. Επιπρόσθετα, η μείωση 

του αριθμού των ριβοσωμάτων που είναι συνδεδεμένα με το αδρό ενδοπλασματικό δίκτυο 

καταλήγει στη μείωση της πρωτεϊνοσύνθεσης και η αύξηση του αριθμού των ελεύθερων 

ριβοσωμάτων υποδηλώνουν την προσπάθεια του νευρώνα να καλύψει τις ανάγκες του με 

σκοπό να επιβιώσει στις μεταβολικές προσβολές. Όταν όμως η μεταβολική προσβολή 

συμβαίνει για μεγάλο χρονικό διάστημα οι νευρώνες οδηγούνται σε κυτταρικό θάνατο 

(Zimatkin και Bon, 2018). 
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Επίδραση Μεταβολικών Προσβολών στην Χρώση των Σωματιδίων Nissl στην CA1 Περιοχή 

Ιππόκαμπου Αρουραίου 

Κατά την εκτίμηση των μορφολογικών διαφορών μεταξύ του φυσιολογικού και των 

μεταβολικών προσβολών (ισχαιμία, υποξία, υπογλυκαιμία) δεν παρατηρήθηκε κάποια 

σημαντική αλλαγή στην μορφολογία των πυραμιδικών κυττάρων της CA1. Εμφανής αλλαγή 

στη μορφολογίας των πυραμιδικών κυττάρων παρατηρήθηκε στην CA1 στην περίπτωση της 

ισχαιμίας και της υπογλυκαιμίας καθώς τα κύτταρα φαίνεται να μοιάζουν μορφολογικά 

μεταξύ τους. Η ένταση του σήματος τείνει να μειώνεται υπό την επίδραση της ισχαιμίας και 

της υποξίας συγκριτικά με το φυσιολογικό και την υπογλυκαιμία που εμφανίζουν πιο έντονη 

ένταση σήματος.  

Σύμφωνα με τους Busl και Greer (Busl και Greer, 2010), οι πυραμιδικοί νευρώνες CA1 είναι 

πιο επιρρεπής όταν η ισχαιμία διαρκεί για μεγάλα χρονικά διαστήμα με αποτέλεσμα την 

απώλεια μνήμης. Μετά από σύντομες περιόδους ισχαιμίας, ενεργοποιούνται μηχανισμοί οι 

οποίοι είναι υπεύθυνοι για την καθυστέρηση του εκφυλισμού και απόπτωσης των νευρώνων 

της CA1. Σε αυτήν την περίπτωση οι νευρώνες που έχουν υποστεί βλάβη δεν επανέρχονται 

στην αρχική του κατάσταση, αλλά τα αγγεία καταφέρνουν να επιβιώσουν. 

Συμπερασματικά, περαιτέρω μελέτες είναι απαραίτητες προκειμένου να διευκρινισθεί η 

πιθανή επίδραση  στον κυτταρικό θάνατο ή αυτοφαγία των κυττάρων, αλλά και στην 

έκφραση άλλων νευρωνικών και αγγειακών δεικτών. 
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